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Audiophilia

A
n obscenely large percentage of the world's population
shares the same passion - music. If it isn't teenyboppers
bouncing about to Britney, it's fanatical classic rockers

guarding their original vinyl Led Zeppelin records with the ferocity
of a mother tiger. We at Digit too fall into this community, and so
we present to you this Fast Track to Digital Audio - everything you
need to know, and some other things we just thought we'd share.

With the coming of the MP3 and file-sharing revolutions, most of
us now sport music collections spanning a few gigabytes (at a conser-
vative estimate). The first section of this book is dedicated to the most
important thing you can do with this mega collection - play it! Of
course, nobody likes music that doesn't sound perfect, so we've ram-
bled on about all the gear you'll need - from high-end speakers to
portable music players to the new "iPod-killing" music cell phones.
You'll also learn to turn your plain old box into a Home Theatre. And
don't miss our handy guide to some absolutely free music online - no
tangling with the law here!

Ever thought, "I wish I could make music like that"? Do you want
to get out of the bathroom and into the clubs with your own priceless
compositions? The second section of this book - Make - will aid you in
your quest for just that. The long journey to the best recording and
mixing studios starts with but a single step, and this is it. Remix
tracks from your own collection or compose your own music and
even use it as a ringtone for your mobile phone - the choice is yours.

How do you bring order to the chaos of your music collection?
The third section of this book will show you how you can organise
that collection so that you're never hunting for that elusive song you
haven't heard in a while.

And finally, the fourth section of this book will turn you into a
benevolent soul - share your music collection and your own original
music with the world! So lend us your ears for the duration of this
book, will you?

Introduction
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Play
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Audio Gear

If you’re into music, we advise you indulge your ears—spend a little
bit and get the best there is! Here, we speak about what you need

for your music to sound really good—sound cards, speakers,
headphones, portable audio players, and phones that double up as
music players. We also touch upon what you need to build a home
theatre based around your PC.
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1.1 Sound Hardware

When it comes to the basic PC hardware for sound, you, of course,
have two options—onboard sound and dedicated sound cards. We
talk about both these.

1.1.1 Onboard Sound
Onboard Sound has improved in a big way since the 2-channel solu-
tions of a few years back. All current-gen motherboards come with at
least 6-channel sound as a de facto standard, with the latest chipsets
from the big guns such as Intel and NVIDIA actually having 8-chan-
nel audio. For example, Intel released “Azalia,” which is the code-
name for its latest 7.1, high- definition audio specification. Other fea-
tures of Azalia or Intel High Definition Audio include multi-stream-
ing capabilities, which gives you the ability to send two or more dif-
ferent audio streams to different locations at the same time, from
the same PC. This means you can play a game’s sounds through your
5.1 speakers while simultaneously voice-chatting on the Net! Also,
there is “jack retasking”—one jack can have more than one function.
The motherboard can sense when a device is plugged into an audio
jack, determine what kind of device it is, and change the port func-
tion if the device has been plugged into the wrong port!

Most mid-range to high-end Intel motherboards from the 925X
series and up sport Azalia, although some boards use lower audio
solutions, mainly due to cost constraints. Azalia is capable of sup-
port for up to eight channels at 192 kHz/32-bit quality.

The ALC 880 and ALC 880D are also 7.1-channel high-definition
codecs providing four 24-bit, 2-channel DACs. This standard
achieves 100 dB sound quality, making these codecs suitable for
high-end multimedia PCs.

SoundMAX is a combination of Analog Devices’ AC’97 CODEC
series and software that enables your computer to have features
that, according to Analog Devices, can even “surpass the function-
ality of premium soundcards at a fraction of the cost.” 
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SoundMAX, too, features intelligent jack sensing, as well as a
user interface. The AudioESP (Audio Enumeration and Sensing
Process) feature of SoundMAX is an advanced jack-sensing and
enumeration feature that eliminates the common connectivity
problems users face when trying to match audio peripherals to
their PC’s I/O jacks. AudioESP notifies users of erroneously con-
nected audio peripherals, guiding them through the process of
connecting peripherals to the correct jacks. SoundMAX also offers
a “virtual dashboard” that allows users to easily manage audio-
related controls. In addition, it includes enhanced audio Wizards
that enable users to set up audio peripherals.

The SoundMAX-class AD1985 audio codec features 6-channel
sound output, variable sample rate conversion, and 103 dB output
with 94 dB SNR. Acer, Intel, MSI, Gigabyte, and Asus all ship
SoundMAX on a lot of their motherboards.

1.1.2 Sound Cards
Creative makes some of the best cards in the market. At the low
end of the spectrum are the Sound Blaster Live series. The mid-
range sees the Creative Audigy series of cards, and if you want only
the best, you have the Creative X-FI card series, the latest and best.

Live! 24-bit
“A good, cheap card” is how the Creative Labs Sound Blaster Live!
24-bit would be best described. Creative calls it “The perfect
upgrade from basic motherboard audio for enhanced music,
movies, and gaming.” Sound Blaster Live! 24-bit supports up to 7.1
surround, and features Creative’s EAX Advanced HD technology.
EAX essentially allows you to enhance your music with features
including Bass Boost, a multi-band graphic equaliser, “audio clean-
up,” and so on. There’s also an external (USB) version available. The
non-USB card retails at approximately Rs 2,250.

Audigy
There are several cards in this series, ranging from the Sound
Blaster Audigy Value to the Audigy 4 Pro.
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Creative calls the Audigy Value
“the upgrade solution for basic
motherboard audio to high quali-
ty 24-bit, 7.1 audio.” Audio quality
is 24-bit / 96 kHz with a 100 dB
SNR. The Audigy 2 Value is a minor
upgrade of the same card. The
Audigy 2 NX is an external USB 2.0
sound solution. The Audigy 2 ZS
features Creative’s 24-bit
Advanced HD audio quality playback with an SNR of 108 dB, and
supports DVD Audio at 24-bit / 192kHz in stereo or 24-bit / 96kHz
in 5.1 surround.

At the upper end of the spectrum is the Audigy 4 Pro, which
pumps the SNR up to 113 dB, and which supports recording of six
channels at 24-bit / 96 kHz. The Entertainment Center software
and infrared remote allow easy
navigation through movies, music
and pictures. The Audigy 4 Pro has
an external I/O hub that allows you
to connect all your music devices
at one time for studio-quality audio creation, according to
Creative. The PCI card connects to the external hub, with the line
outputs (three 3.5 mm stereo jacks) on the PCI card and all the
other connections on the hub.

Indicative prices are about Rs 2,200 for the Audigy Value, Rs
7,000 for the Audigy 2 NX, and Rs 20,000 for the Audigy 4 Pro.

X-Fi
The Creative X-Fi is supposed to be 24 times more powerful than
its predecessor, the Audigy 2 ZS, in terms of processing power.
Unlike any earlier audio technology, the X-Fi Xtreme Fidelity audio
processor allows the user to switch the sound processing of the
card between one of three modes (Gaming, Entertainment and
Audio Creation).
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The X-Fi is the latest and great-
est offering from Creative. There’s
the X-Fi XtremeMusic, the X-Fi
Platinum, the X-Fi Fatal1ty, and
the X-Fi Elite Pro. The Fatal1ty
accelerates gaming performance
with its 64 MB of onboard X-RAM,
as does the Elite Pro.

As with the Audigy 4 Pro and other Audigy solutions, the X-Fi
Elite Pro, Platinum and Fatal1ty consist of a PCI card that connects
to an external hub that’s controlled by a remote.

The Elite Pro is priced at approximately $350 in the US, the
Fatal1ty is about $225, and the Platinum is about $165. As an
example of the price difference for these products between the US
and India, the XtremeMusic is about $110 (Rs 5,200) in the US, and
is Rs 9,000 in India (street price). 

1.2 Speakers

A primary consideration in deciding between 2.1 and 5.1 speaker
sets is whether it’s music you’re intending to use them for on the
one hand, or DVD movies and games on the other. 

2.1 speaker sets are ideally suited for music—more so than 5.1
systems. A good 2.1 speaker set will outperform a 5.1 set in the
same price range if MP3 tracks and audio CDs is what you’ll be lis-
tening to. This is because most music, such as that on a regular
CD, is encoded for two-channel playback. When you play these on
5.1 speakers, your sound card is encoding stereo sound into 5.1,
and there is bound to be some distortion. It’s pretty straightfor-
ward, really: it was recorded on two channels, so it’ll sound better
on two channels… The subwoofer doesn’t result in too much of a
distortion, because all that happens is that the low-frequency
sounds get channelised to it, but hard-core audiophiles won’t
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stand up for even that: they’ll swear that it’s pure stereo speakers
that deliver stereo sound best. In fact, some audiophiles swear that
stereo sound is best listened to using quality headphones.

Whatever the case, our point stands that if it’s stereo music (DVD
Audio being an exception, since it’s been recorded through more
than two channels) you’re going to listen to, with the occasional
game thrown in, you’re better off with 2.1 speakers—not to mention
that if you’re on a budget, 2.1 would naturally be the way to go.

5.1, like we said, is for movies—DVD movies in particular—and
games. It’s all about immersion and the surround experience. DVD
movies that use standards such as DTS and Dolby Pro Logic IIx need
a 5.1 system for accurate sound reproduction. And as any gamer
will tell you, 2.1 systems just don’t cut it—there’s almost no real-
ism if you’re talking about today’s immersive games!

If you’re not really an audiophile and would like to be
immersed in music, then again, 5.1 is the way to go. You sit in the
middle of the room and the sound seems to fill the room. That’s
not accurate reproduction, like we said, but some folks like it that
way—it’s a little bit like using the graphic equaliser: you add and
subtract from the sound, making it less faithful to the original,
but if that’s the way you like it—go ahead with 5.1!

We proceed to talk about the four best 2.1 speaker sets from
our speaker shootout in the May 2006 issue of Digit. These are (not
in any particular order) the Altec Lansing FX-6021 and MX-5021,
and the Logitech X-230 and Z-2300. These are the four sets you
should be looking for.

1.2.1 Speaker Sets (2.1) 
Remote Controls
Both the Altec Lansing models come with wired control pods as well
as wireless remote controls. There are volume, bass and treble con-
trols on both the wired and wireless units. The Logitech Z-2300 has
a wired control pod with a large volume dial and a smaller bass dial.
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Stands
Stands for speakers are a welcome feature, especially for the sub-
woofer. The stands on the Altec Lansing FX-6021 were of solid
metal and good build quality. The stand quality of the Logitech X-
230 is good, too: it also has a swivel base for wall mounting.

DVD Audio
Whether it’s vocals, treble or bass, the Altec Lansing MX-5021 is
the best 2.1 set we’ve tested as far as DVD audio is concerned.

Audio CDs and MP3s
With audio CDs, the Altec Lansing MX-5021, with its very high
dynamic range, doesn’t distort the sound even at high volumes.
Vocals at extreme ranges are handled comfortably by this set. To
put it briefly, both the Altec Lansing sets reproduce audio CD
sound very well indeed. MP3s, too, play very nicely on the Altec
Lansing sets.

Bass And Treble
When it comes to deep bass—as in 50 Hz—the Altec Lansing MX-
5021 is amongst the best we’ve tested. The FX-6021, though not just
as good, also reproduces bass well. And when it comes to extreme
treble, the Altec Lansing MX-5021 and the Logitech Z-2300 are the
best performers.

1.2.2 Speaker Sets (5.1)
Here, we mention the four best sets in our comparison in the May
2006 issue, along with their strong points.

Philips MMS 5.500 i/C
❍ Clear sound with DVD audio, reasonably

low distortion
❍ Good performance with audio CDs
❍ Reasonably good MP3 playback
❍ Inbuilt FM radio
❍ Looks good
❍ Costs just Rs 5,000!
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Philips HTR5000
❍ External decoder/splitter for DTS and

Dolby Pro Logic II
❍ Looks great, with narrow subwoofer

and satellites with horn-like
micro drivers

❍ Reasonably good for gaming
❍ Excellent DVD performance.

Clear sound with hardly any distortion: flat  bass; highs and
ambient sounds faithfully reproduced

❍ Good audio CD reproduction
❍ Reasonably good MP3 playback
❍ Inbuilt FM radio
❍ Reasonably priced at Rs 13,000

Logitech Z-5500D
❍ External decoder/splitter
❍ Decoder is capable of a

sampling rate of 96 KHz
at 24-bit

❍ Large subwoofer (10-inch driver); 187 watt RMS; excellent low
bass reproduction

❍ Control pod / decoder has a blue backlit LCD panel
❍ Good DVD playback; excellent treble, vocals and bass
❍ Some of the best audio CD and MP3 sound we've heard
❍ Fully THX-certified
❍ Probably one of the best 5.1 sets out there if cost (Rs 28,000) is

not a constraint

Creative Inspire GD580
❍ Fully THX-certified
❍ External Dolby decoder/splitter
❍ Good DVD playback, but bass lacks

punch
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1.3 Headphones

Most of us make the mistake of thinking that it’s only through
speakers that you can really listen to music. The fact is that the
high-end headphones of today, though expensive, reproduce
sound with such high fidelity that your experience with one of
them might make you a convert! Two points are in order here:

❍ Using the headphone amplifiers we’ll talk about, your hi-fi
headphones can actually sound like speakers, with all the spa-
tial effects.

❍ Sealed and noise-cancelling headphones are great for commutes
and such, and also when you want to listen to music with no
ambient sound. These are especially useful in situations when
you cannot afford to pump up the volume on your speakers,
such as when you’re listening at night.

Here we talk about four headphone sets in particular, and
about headphone amplifiers in general. You can order this equip-
ment from headphone.com and some other sites, as well as from
ebay.com, but do remember the added shipping charges, as well as
the import duties.

Many audiophiles argue that the best listening experience is
provided by audiophile-grade headphones, not speakers!
Audiophile-grade headphones tend to be “open” headphones.
Open headphones allow the sound waves to propagate away from
the ear freely. This means you’re not isolated from outside sounds,
and besides, sound through open headphones can be easily heard
by others in your vicinity. But as a result of their open nature, they
sound more “expansive” due to the lack of resonance: the sound
isn’t cramped between your ear and the headphone cap.

To expand on this further, the closed headphones you’re prob-
ably used to, are sealed, which attenuates the sound waves that
propagate away from the ear. The reproduced sound is therefore
not nearly as accurate. The sealed chamber that is created reduces
the “soundstage”—the area between two speakers that appears to
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the listener to be occupied by sonic images—and creates an artifi-
cial boomier bass effect. It’s all intuitive, actually: imagine your
ears surrounded and enclosed by cups (closed headphones), and
imagine a “ventilated” situation (open headphones). The latter
will, of course, sound more natural.

Sennheiser HD650/HD600
Sennheiser is one of the most
respected names in headphones,
and their headphones are amongst
the world’s best. The HD650 is their
top-of-the-line model, and the
HD600 is almost the same. These
currently retail at $400 (Rs 19,000)
and $300 (Rs 14,000) respectively.

The HD600 and HD650, in comparison to other open audio-
phile headphones, are somewhat partial to treble. When you lis-
ten to these—as also to the Grados we mention next—trust us,
you’ll hear sounds in your music that you never knew existed!

Grado RS-1
Grado is another very respected name in headphones, though not
as well-known as Sennheiser. Audiophiles are a very vocal lot, and
will speak endlessly of the virtues of the phones of their choice.
There are many who believe the Grado RS-1 is the best pair of head-
phones out there, barring those used
in professional recording studios,
which cost thousands of dollars. The
chassis of the RS1 is handcrafted
from cured mahogany wood! The
bass, in our opinion, is better than
that on the high-end Sennheisers. A
four-word summary of these phones
would be “breathtaking realism and
detail”—but read the numerous
audiophile reviews on the Internet
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for yourself. After all, this is a serious investment you’re going to
make—this set retails for about $450 (Rs 21,000).

Sennheiser RS 140
Ah, wireless headphones! Not
quite in the league of the
HD650, the RS 140 is one of the
best sets of wireless head-
phones you can get. Imagine
walking around your room—
and even outside your room,
say in the garden, with your
headphones on! The problem
is that headphones in the class
of the two we’ve mentioned
above cannot be made wire-
less, so you’ll have to settle for
something less than perfect. However, what we mean by “perfect”
here is “somewhere in heaven,” and it’s much more than likely
that you’ll love this set more than the 5.1 speaker set you have.

The RS 140 is a closed headphone set. It features independent
balance control for left/right volume adjustment, which excellent
if one of your ears hears a little better than the other. The sealed
ear-cup design provides a good degree of isolation and attenuation
of external noise. Hook it up to your TV and listen to the news, or
hook it up to your hi-fi and listen to music—without disturbing or
being disturbed.

Although the RS 140 would not be a headphone for demanding
audiophiles, it’s a candidate for those looking for both external
noise suppression and very acceptable wireless sound.

The base range is 100 metres, as stated by Sennheiser. This
might vary depending on obstructions or barriers in the line of
transmission from the base unit, but it should still have a decent
reach inside and outside the home for the majority of users. The
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phones operate for around 22 hours on a single charge.
Approximate price is $200 (Rs 9,500).

Etymotic ER4-S
Sealed earphones. Trust us,
there’s absolutely nothing
better than sealed phones
such as these for your daily
commute. Plug them
inside your ears and you
can hear nothing from the
outside—nothing! The driv-
ers are tiny, and if you
open up the phones, you’ll
find something about a
millimetre in diameter
pumping sound into your
ears—this is a marvel of
technology. But alas, as
you might expect, the bass is less than perfect—but you can’t
expect booming, thumping bass emanating from a one-millime-
tre orifice: that would simply be too demanding on technology!
Treble and mids, however, are near-perfect, and even if you aren’t
in a noisy environment, the noise isolation makes for a surreal
listening experience.

A further note about the bass is in order here: bass isn’t just
about thumping and booming. For all your lives thus far, you’ve
probably associated bass with just that—thumping and booming.
But with sealed earphones, the bass sounds different. It’s very
hard to describe it: one way of saying it would be that you don’t
“feel” the bass, you actually “hear” it. So is this more accurate
reproduction? We can’t say. Bass is a contentious issue, so you’ll
just have to listen to these phones to decide for yourself.

But how do you sample these phones without buying them?
Our advice would be to take our word for it—forget about the bass
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for now, and think about near-audiophile-quality sound with near-
complete noise isolation. You’ll absolutely love the sound, and
might just ditch your speakers! This set retails at approximately
$200 (Rs 9,500). Go ahead, indulge your ears!

1.3.1 Headphone Amplifiers
The phones we’ve talked about need amplifiers, on account of
their high impedance. Some from headphone.com have a “cross-
feed” feature whereby music will sound binaural. (It won’t techni-
cally be binaural as in a binaural recording, but still.) Think about
this: when you’re listening to speakers, both your ears are listening
to all the speakers. But when you’re using headphones, the left ear
hears only what’s coming through on the left—and the same for
the right ear. With crossfeed, the amplifier inserts a little time
delay and feeds the right sound into the left ear, at a lower volume,
and feeds the left sound into the right ear. Both your ears will
therefore be listening to all the sound! You literally won’t believe
your ears when you turn the button on for the first time—you’ll
feel your headphones have “opened up,” and that you’re listening
to speakers! It sounds much, much natural, and you’ll wonder
what on earth you were doing listening to terrible monaural
sound for all these years!

The amplifiers are worth it just for the crossfeed switch, in our
opinion. But remember that for high-impedance headphones such
as the Sennheiser HD600 and Grado RS-1, you’ll need the amplifier
if you’re listening from a portable music source.

Head to headphone.com and click the “Amps” tab. You’ll find
that those in the AirHead series (in The Mobile Line) and those in
The Micro Line are reasonably affordable—for those serious
enough about music, that is.
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1.4 MP3 Players

Audiophiles would balk at the idea of using portable MP3 players,
what with their piddling earphones and the 128 kbps bitrate that are
typically packed into them. But very few of us are true audiophiles!

The fact is, MP3 players are great for the daily commute.
They’re good for ambling around the place with music being
piped into your ears. And if you can work while listening to music,
you can mix business with pleasure, as it were, while in office.
They can double up as backup storage devices. In general, they’re
fun accessories to have! You might want to shop around for better-
quality earphones than those bundled with typical MP3 players,
though—you just might find something that sounds way better.

Hard drive-based players offer larger capacities, but they
can’t stand jerks and such—you can’t go jogging with a hard-disk
based player strapped to your belt! Flash-based players are small-
er, both in size and capacity. The good news is that they’re
improving in terms of storage space. Here, we mention the high-
lights of two Flash-based players and two hard-disk based players,
the winners in our portable audio player comparison test in the
May 2006 issue.

1.4.1 Flash-based

SAFA SF-Q100
❍ 1 GB capacity
❍ Great looks
❍ Record CDs directly without the need for a PC;

voice recording
❍ 3D sound and equaliser functions; excellent

sound quality
❍ 40 mW output power - quite good
❍ Colour 1-inch OLED display
❍ Lasts 17 to 20 hours on 2 AAA batteries
❍ Supports MPEG 1/2/2.5/3 Layer 3, WMA, ASF
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Samsung YP-D1
❍ 1 GB capacity
❍ Street Mode, which enhances listening

outdoors
❍ Capable of detailed mids and clear highs
❍ 11 equaliser presets and a seven-band

user-defined equaliser
❍ 2MP camera
❍ 1.8-inch display
❍ FM radio
❍ Line-in, FM, voice recording
❍ 20 hours rated audio battery life
❍ Supports MP3, Ogg Vorbis, WMA, WAV

1.4.2 Hard drive-based
Apple iPod Video (30 GB)
Much has been said and heard about the iPod
Video, and we don’t really need to repeat all
that, but for the uninitiated, this is one of the
best portable media players available. Here are
some of its features.
❍ Very intuitive user interface
❍ Excellent sound quality; right mixture of bass

and treble
❍ Great 30 GB capacity
❍ Audio formats supported include MP3, AAC, WAV, AIFF, MP3

VBR, Audible, and Apple Lossless
❍ Voice recording
❍ Volume limiter
❍ 22 equaliser presets
❍ Easy drag-and-drop using iTunes

Creative Zen MicroPhoto 8 GB
❍ 8 GB capacity
❍ Winner of the Best of CES 2005 award!
❍ Intuitive menus in bright colours
❍ 15 hours of playback on a single charge
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❍ FM radio with 32 presets
❍ Voice recording
❍ Eight equaliser presets
❍ Decent-quality earphones
❍ Features a vertical touchpad

1.5 Cell Phones

Here’s about five cell phones that can ably act as portable music
players.

Sony Ericsson Walkman W550i
(Rs 10,000 approx.)
The W550i Walkman has FM radio and a
digital music player. There are speakers on
the top and the side. CD ripping software is
included—you can drag and drop using the
Disc2Phone software. When you turn the
phone on, you’re prompted with a phone or
music-only option.

In addition, the W550i has a 1.8-inch colour screen, and a 1.3-
megapixel camera with video recording and digital camera
menus. This Walkman phone has Sony’s trademark Mega Bass, as
well as a stereo widening feature.

The downside is that there’s only
256MB of internal memory, and no expand-
able memory! The phone comes with stereo
headphones, and the sound from the
speakers is tinny according to many users.

Sony Ericsson Walkman W800i
(Rs 18,000 approx.)
In the memory department, the W800i does
better than the W550i, with a 512 MB
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Memory Stick PRO Duo included. Of course, you can put in a larger
Stick if you choose. There’s FM radio on this phone as well, and also
CD ripping software. When you turn the phone on, you’re prompted
with a phone or music-only option. 

Sony Ericsson K750i
(Rs 13,500 approx.)
Dedicated buttons for play/pause and vol-
ume control enable you to listen to music
without entering the menu at all during
playback, and press-and-hold functionali-
ty also enables track skipping. Although
the phone has the ability to create
playlists is present, there’s no way to for-
ward through songs without entering the
music player interface. There’s a graphic
equaliser with several presets.
Unfortunately, the K750i doesn’t provide
an integrated 3.5 mm stereo jack, but relies on a dongle that must be
purchased separately.

Nokia N91
(Rs 38,000 approx.)
The N91 has an integrated 4 GB hard disk—good enough for most
music lovers. Nokia has integrated a 3.5 mm stereo headset jack
into the handset, negating the need for cumbersome dongles.
Audio quality is reported to be
superb. Format support includes
MP3, AAC, WMA and M4A, and
there’s also an included stereo head-
set with remote control. The N91
comes with a dedicated application
for music management.

The N91 pauses music playback
when receiving incoming calls and
resumes playback upon hanging up.
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There are dedicated volume controls, as well as an 8-band equalis-
er, and the ability to record music through a line-in connector or
from the FM radio.

Nokia 3250
(Rs 16,500 approx.)
Although not as capable as Nokia’s best
music phone, the N91, the 3250 is a good
enough music phone, with reasonably
good audio quality and decent music man-
agement. It’s very short on storage, with
only 10 MB onboard, requiring any use at
all to be backed up by miniSD cards. It also
lacks a 3.5 mm stereo earphone jack. 

1.6 Setting Up Speakers

Setting up 2.1 speakers requires no more than a couple of tips to
explain:

❍ If your speakers are widely spaced apart, angle them towards each
other, and if they are placed close together (which they would if
you have limited space), angle them away from each other.

❍ Place the subwoofer facing a wall for better bass. If the bass
seems too much, move it a little away from the wall.

❍ Your speakers should be roughly at ear level. Use speaker stands
if you need to.

Now consider 5.1 speakers.
❍ You should be facing one of the longer sides of the room for the

speaker arrangement.
❍ All the speakers should be at least a foot from the walls.
❍ The speakers should be mounted at approximately ear level.

Even if they can’t be, they should all be at approximately the
same height. Some people say the rear speakers should be a lit-
tle above ear level—experiment with this.
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❍ All the speakers should point at where you’re sitting. But there’s
a difference of opinion as to how far they should be from you.
Most agree that the front and centre speakers should be at the
same distance from you. But while some say that the rear speak-
ers should also be at the same distance, some say they should be
a bit further away. Experiment!

❍ Place the front speakers in an equilateral triangle with your seat,
and closer to your seat than the TV or monitor is. Angle them
inwards by about 30 degrees so that most of the sound seems to
be coming from the monitor or TV.

❍ Place the centre speaker on the monitor or TV, or somewhere in
the TV cabinet, hopefully at ear level.

❍ The subwoofer can be placed anywhere convenient, but it’s gener-
ally considered better to place it near the front. But experiment
with it such that you can’t make out where it is when music is
playing. For better bass, place it somewhat close to a wall.

❍ Place the rear speakers behind and to the sides of the viewing
seat. The spacing between them should be about double the
spacing between the front speakers. Since they’re so far apart,
the principle we stated in the case of 2.1 speakers holds—angle
them towards each other.

1.7 Setting Up A Home Theatre PC

If you’re about to buy a PC now, think about a home theatre—your
PC doesn’t have to be stuffed away in your bedroom; you can bring
it out into the living room and, coupled with a DLP projector and
great 5.1 speakers, turn it into a complete home theatre solution.
Here’s what you’ll need.

Processor, motherboard, power supply: For the processor, we’d
recommend an AMD 939-pin Athlon64 3800+ or a dual-core Athlon
X2 4400+. For the motherboard, consider the PCIe Asus A8N-VM
CSM. It’s based on the NVIDIA GeForce 6150 + nForce 430, has sup-
port for dual-channel DDR400 RAM, an integrated GeForce6 GPU,
dual VGA output—DVI-D and RGB, NVIDIA Gigabit LAN with
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NVIDIA ActiveArmor Firewall, and SoundMAX High Definition
Audio.

Get a 400-watt power supply from Antec or VIP.

RAM and hard disk: You need at least 512 MB of DDR RAM. We’d
recommend no less than 200 GB for the hard disk, and we recom-
mend Western Digital because of its performance in our tests. 

DVD-Writer: Since you’ll be handling a lot of audio and video, you
obviously need a DVD-Writer. We recommend either Sony or Lite-On.

Coming to the audio and video, 

Sound Card: Recommended for a home theatre is either a Creative
Audigy or, if you have the money to spare, a Creative X-Fi
XtremeMusic. See §1.1.2 for more.

Speakers: We recommend the Logitech Z-5500D, if price is not a
constraint. If it is, you can make do with the Philips HTR5000. For
how to set up 5.1 speakers, refer to §1.6 and also the workshop in
the magazine.

Projector: The Sharp XR-10S, an 800 x 600 DLP. It retails at Rs
70,000 approx. For how to set up a projector, refer to the workshop
in this month’s anniversary issue.



There are some terms you’ll very often come across in digital
audio—for example, sampling rate. And then there are the

various audio formats. This little chapter will prepare you for what’s
to come in the later chapters, by way of a brief introduction to terms
and formats.
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2.1 Sampling Rate, Quantisation, Bitrate

Music (or any sound sequence) is composed of many different fre-
quency signals. A single tone—say the beeps you hear when you get
an engaged tone during a phone call—is a single frequency, rather,
a non-continuous signal composed of a single frequency. Now,
when you listen to one second of music, you’re listening to several
signals of different frequencies at the same time. Now, music is
complex—don’t think that a drumbeat (which may sound monot-
onous by itself) is a single frequency: it’s actually composed of sig-
nals of many frequencies.

Now think of a signal of a single frequency (of which there are
many in one second of music). In the analogue world, this is drawn
as a waveform, and looks something like this:

Music is composed of a
lot of these together. When
you look at the spectrum
analyser (the light bars
moving up and down),
remember that what
they’re showing you is how
loud each of the frequen-
cies is in the music that’s being played. When there’s a crash of
cymbals (lots of treble, or high frequencies), the high frequencies
like this one below become more pronounced, and the lights on
the right go up.

Now, how is this con-
verted to digital? What we
mean by digital is ones and
zeroes; so how is a shape
like this represented as ones
and zeroes? The answer is
simple, but read on careful-
ly: what does the waveform
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above represent? It can rep-
resent the voltage, or
sound pressure level, or
loudness, of that frequency.
Essentially, the vertical
level of the wave represents
how much of this frequency is
present in the music. So, we
“look” at the wave continu-
ously—several times per second—and note the value (the height).
Each time we look at it, we represent the height by an approxima-
tion. This is called quantisation.

In the image above, the actual height may be 5.32, but we rep-
resent it as 5. The 0.32 is the “quantisation error.”

So where does the “digital” come in? It’s simple: that “5” is rep-
resented digitally, as “101”. (If it were indeed “5”.) Now, the more
the number of levels we define for our representation, the more
accurate our representation will be. Say we have only 10 levels,
from 1 to 10. Then 5.3 would be coded as 5, 6.8 would be coded as
7, and so on. But say we have 20 levels. Then 5.3 would be coded as
5.5, 6.3 would be coded as 6.5, and so on. We’re getting more accu-
rate. Now, representing 10 levels only needs four bits; representing
20 levels requires five bits.

We can now define
the sampling rate and
bitrate. The sampling
rate (the “44.1 kHz” you
see in Winamp or any
media player when a clip
plays) is the number of
times the waveform is
“looked at” per second. A
low sampling rate means
we only look at the waveform at points A, B, and C above.
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A high sampling rate means we look at it more times per sec-
ond, at points A, B, C, D, and E, as below:

The bitrate is the
number of bits used to
hold the data captured
every second. Music is
sampled at rates like
44.1 kHz, with 16 bits or
24 bits (or so) used to
hold the data at each
sample. So the bitrate of
music sampled this way
would be

44,100 x 16 x 2 = 1,411,200 bits per second, or 1,378 kbps, or
1.35Mbps.

Some typical sampling rates:
44.1 kHz CD, DAT
48 kHz DVD-Video, DV camera, DAT
96 kHz DVD-Audio

2.2 Your MP3s: Good Enough?

Consider this: cymbals (our reference point for high frequencies!)
can be as high as 10 kHz (our ears can hear sounds between 20 Hz
and 20 kHz). Now, think of the sampling as the frames in a movie,
which, as you know, are usually taken 24 times a second. That is,
there are 24 frames that you see every second. If we’re sampling
the cymbals at 44.1 kHz, only approximately four “frames” per sec-
ond are representing the cymbals. In contrast, the human voice is
somewhere around 1 kHz, and that’s 40 “frames” per second.
Hence, high frequencies need a higher sampling rate to be repre-
sented more accurately in the digital format.

Now, what we mentioned above—44.1 kHz sampling at 16 bits—
comes to 1378 kbps. That’s something like CD quality (though strict-

A    B     C    D    E



ly speaking, CD quality comes to 2 Mbps or so, because of additional
bits required for error correction and metadata), but your MP3s are
typically 128 kbps! Even 256 kbps comes nowhere close to 1378 kbps.

Why, then, do 128 kbps MP3s sound OK? It's because of certain
limitations—not everyone can listen very well beyond 10 kHz, and
not everyone can make out fine gradations: it’s about sensitivity.
Yes, some people can indeed make out the difference between 128
kbps MP3s and 256 kbps MP3s, and between these and CD quality.
But then, as you’ve inferred, a higher bitrate means more space
required on your hard disk or MP3 player—so it’s a trade-off.

Talking about MP3, we move on to a discussion of digital audio
formats: uncompressed, lossless compressed, and lossy com-
pressed (MP3 falls in the last category because the 128 kbps means
that the remaining bits are forever lost. Remember that if you rip
a CD to MP3 and then throw the CD away, you are actually throw-
ing something away!)

2.3 Uncompressed Formats

WAV (or WAVE)
This is a Microsoft and IBM audio file format standard for storing
audio on PCs. It happens to be the native digital audio format in
Windows. In WAV files, 8-bit or 16-bit samples are taken at rates of 11
kHz, 22 kHz or 44.1 kHz. The highest quality (16-bit at 44.1 kHz) uses
88 KB of storage per second of music. The WAV format is widely used
as the medium for professional recording and editing. For creating
audio CDs, WAV files are converted to the CDDA audio format. Both
CDDA files and WAV files at their highest sampling rates take up a
similar amount of storage space, and are not compressed (like MP3
is). But WAV is not the same as CDDA, as some people believe.

AIFF
Audio Interchange File Format is another format used for storing
digital audio data. It supports a variety of bit resolutions, sample
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rates, and audio channels. The format is very popular on Apple
platforms, and is widely used in professional programs that
process digital audio waveforms. The format was co-developed by
Apple Computer based on Electronic Arts’ Interchange File Format
(IFF). There is also the AIFF-Compressed (AIFF-C or AIFC) format,
which supports compression ratios as high as 6:1.

AIFF is one of the two most-used audio file formats on Mac
operating systems. The other is Sound Designer II (SDII).

The extension for AIFF is .aif when used on a PC. 

AU
The .au file format, originally by Sun, isn’t widely supported out-
side the UNIX community. “AU” is short for “audio.” It is the stan-
dard audio file format for the Java programming language.

2.4 Compressed Lossless Formats

Lossless compression is a compression technique in which data
can be decompressed back to its original form without any loss.
The decompressed file and the original are identical. For example,
ZIP is used to compress documents etc.; there are similar com-
pression techniques for audio and video. Apple Lossless, WMA
Lossless and FLAC are examples of lossless compression applied to
CD audio. These methods can reduce a full audio CD only to about
half its original size.

A word about containers is in order here. A container format is
a file format that can contain various types of data, compressed in
a manner of standardised codecs. The container file is used to be
able to identify and interleave the different data types. Simpler
container formats can contain different types of audio codecs,
while more advanced container formats can support audio, video,
subtitles, chapters, and metadata, along with the synchronisation
information needed to play back the various streams together.



Apple Lossless
Also known as Apple Lossless Encoder, ALE, or Apple Lossless Audio
Codec, ALAC, this is an audio codec developed by Apple for lossless
compression of digital music. Apple Lossless data is stored within an
MP4 container with the filename extension .m4a. Apple claims that
audio files compressed with its lossless codec will use up “about half
the storage space” that the uncompressed data would require.
Testers have found that compressed files are about 60 per cent the
size of the originals, similar to other lossless formats. Compared to
most other formats, Apple Lossless is not as difficult to decode, mak-
ing it practical for a limited-power device such as an iPod.

FLAC
An acronym for Free Lossless Audio Codec, this is a popular format
for audio compression. It is suitable both for everyday playback
and for archiving audio collections. It was developed by the
Xiph.Org Foundation (www.xiph.org), and is royalty-free.

WMA Lossless
Windows Media Audio actually is the name of Microsoft’s solution
for digital audio. WMA codecs once were only lossy, but with the
release of Windows Media Encoder 9 Series in early 2003,
Microsoft provides the option of lossless compression by Windows
Media Audio 9 Lossless codecs. WMA Lossless is, formally, a digital
audio file format that compresses an audio CD to a range of 206 to
411 MB, at bitrates of 470 to 940 kbps. It uses the same .WMA file
extension as other Windows Media Audio formats.

2.5 Compressed Lossy Formats

Such formats permanently discard data to achieve reduction in
file sizes. But to most ears, music in such formats is good enough
for everyday listening.

MP3
A number of techniques are employed in MP3 to determine which
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portions of the audio can be discarded. MP3 audio can be com-
pressed with different bitrates, providing a range of tradeoffs
between data size and sound quality. Typically, rates chosen are
between 64 and 320 kbps. (Remember that uncompressed audio as
stored on a CD has a bitrate of 1411.2 kbps (16 bits/sample x 44100
samples/second x 2 channels). With too low a bit rate, “compres-
sion artefacts”—sounds that were not present in the original
recording) may appear in the reproduction.

MP3 Surround, a version of the format supporting 5.1 channels
for surround sound, was introduced in December 2004. MP3
Surround is backward compatible with standard stereo MP3, and
file sizes are similar. 

WMA
Windows Media Audio files are supposed to offer the same audio
clarity level when you encode a piece of music at 96 kbps that MP3
does when it is encoded at 128 kbps. WMA is a proprietary com-
pressed audio file format developed by Microsoft. It was initially a
competitor to the MP3 format, but with the introduction of
Apple’s iTunes Music Store, it has positioned itself as a competitor
to the Advanced Audio Coding format used by Apple. WMA is part
of the Windows Media framework. WMA is second only to MP3 in
popularity in terms of number of devices supported.

AAC
Advanced Audio Coding (AAC) is also known as MPEG-2 Part 7. It
was popularized by Apple through its iPod and iTunes Music
Store. AAC was designed as an improved-performance codec rela-
tive to MP3.

Apple is doing a lot to promote AAC, and here’s a snippet from
Apple’s site about the format:

❍ AAC provides audio encoding that compresses much more effi-
ciently than older formats, such as MP3, yet delivers quality
rivalling that of uncompressed CD audio.



❍ When compared side-by-side, AAC proves itself worthy of replac-
ing MP3 as the new Internet audio standard. Take a look at
these AAC advantages over MP3:

❍ Improved compression provides higher-quality results with
smaller file sizes

❍ Support for multi-channel audio, providing up to 48 full fre-
quency channels

❍ Higher resolution audio, yielding sampling rates up to 96 kHz

❍ Improved decoding efficiency, requiring less processing power
for decode

❍ In numerous comparison tests, AAC comes out on top. Check out
these impressive results:

❍ AAC compressed audio at 128 kbps (stereo) has been judged by
expert listeners to be “indistinguishable” from the original
uncompressed audio source.

❍ AAC compressed audio at 96 kbps generally exceeded the quali-
ty of MP3 compressed audio at 128 kbps.

Ogg Vorbis
Ogg is a patent-free container format designed for efficient
streaming and file compression (storage). “Ogg” refers to the file
format which includes a number of separate independent open
source codecs for audio, video and text (such as subtitles). Because
the format is free, Ogg’s various codecs have been incorporated
into a number of different free and commercial media players.

“Ogg” also often refers to the audio file format Ogg Vorbis, that
is, Vorbis-encoded audio in an Ogg container. Vorbis is a lossy
audio compression (codec) project headed by the Xiph.org
Foundation. It is frequently used in conjunction with the Ogg con-
tainer and is then called Ogg Vorbis. Although the Vorbis format
is often simply referred to as Ogg, this is technically incorrect as
Ogg is a container format while Vorbis is an audio codec.
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2.6 What Format Should I Use?

To the extreme audiophile, even a CD doesn’t sound as good as
analogue. But since we’re talking digital audio here, what audio
format is best suited for ripping your CDs into? For some people, it
makes no difference—128 kbps MP3s sound as good as anything
else, especially when they’re listened to on lo-fi equipment with lo-
fi earphones. But the more discerning amongst us are concerned
about formats, while still wanting to save space on their hard
disks or portable audio players.

There’s a large variation in how people perceive music, and the
best way to figure out what format you want to use is to experi-
ment by yourself, encoding at different bitrates. But still, here’s
one reviewer’s take we found on crutchfieldadvisor.com:

“The question before the aspiring digital music enthusiast is,
which format sounds the best? The market abounds with portable
MP3 players, almost all of which are compatible with MP3. Most
can also play WMA; some can handle AAC files. Most players
decode and play back files directly from their original file format,
but some portables come with software that transcodes files into
a separate format, which is then read by the player. But in either
case, the quality of the sound that reaches your ears depends on,
among other things, the quality of the codec you used to save the
music to your hard drive in the first place. So I decided to set up a
listening test to find out which of those codecs would come out on
top in terms of sound quality.

“The low-bitrate MP3 was everyone’s least favourite. One lis-
tener noted a lack of overall detail, as well as ‘metallic artefacts’
replacing the high frequencies.

“Secondly, I was surprised to find that the uncompressed file
did not receive the highest rating—that honour went to the high-
bitrate AAC file. Perhaps I should have expected this since, in an
earlier attempt at a listening test that pitted 96 kbps, 128 kbps,



and 160 kbps files against each other, my co-workers had a much
more difficult time finding differences in the sound quality.
Apparently, given the limitations of a computer-and-headphones
listening environment, the differences between high-bitrate
sound files and uncompressed audio are too subtle for most lis-
teners to easily notice. Still, the high-bitrate AAC file was clearly
preferred over its MP3 and WMA counterparts—a testament to
AAC’s effectiveness.

“WMA performed well, too, edging out AAC at the lower
bitrate. (It was interesting) to find that the 64 kbps WMA file
received the exact same average rating as the high-bitrate MP3 file.
So, would my co-workers who listen to 128 kbps MP3s be just as
happy with their music’s sound quality if they saved it in WMA for-
mat, in a file taking up half the hard drive space? It appears so—
although it’s important to note that results may vary depending
on the genre of music they’re listening to, as well as the encoding
software they use to compress the music.”
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Players

There are many media players out there—you might have
discovered one for yourself that you like; if you have, stick with

it! If, however, you’re new to playing around with audio on your
computer, we present here a brief introduction to three of the most
popular media players there are. Note that all these can also play
video, but we’ll be talking about them in terms of audio.
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3.1 Winamp

Winamp is one of the most versatile media players around. It sup-
ports all the popular audio formats, some via downloadable plug-
ins. Plugins give the basic player almost any functionality you
might require. Visit www.winamp.com/plugins. The plugins are in
six categories, which we’ll get into in a while. Here is a brief intro-
duction to some of Winamp’s features. We encourage you to
explore all the menus—one great thing about Winamp is that it
explains most options. For example, under Preferences > General
Preferences > Plugins > Input, when you click on a plugin, there’s
an About button that gives you information about it.

On the front panel, you’ll see, amongst other things, the pre-
amp and the graphic equaliser. The preamp is something most

Winamp’s classic skin—is rather bare-bones. The components—main window,
equaliser, playlist, Media Library, and video window—are dockable
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other media players don’t have; it’s something like a volume con-
trol for the equaliser. When you turn it right up, all the frequen-
cies you control using the equaliser are pumped up, and the effect
of sliding a particular frequency up or down will be more pro-
nounced. Another setting you might not know about is the “Auto”
button: when you do a trial and error and come upon a setting
that’s perfect for a particular song, select Presets > Save > Auto-
load preset… The next time that song plays, the equaliser settings
you chose to Auto-load will, well, automatically load.

When you right-click anywhere in Winamp (except on a song
in a playlist), you’ll come across Options > Preferences. There’s a
ton—and we mean a ton—of options here, probably more than in
other media players. For example, one setting you won’t see in
other players is “Priority class”—the higher this setting, the more
the CPU power Winamp will use. Keep it at Idle or Normal for most
purposes; if you have a slow computer, and opening a document
makes a track “skip,” you might want to change it to High. (Track
skipping is audible as a small break in the playback.) “Realtime” is
not recommended unless your tracks keep skipping all the time.

Under Plug-ins > Input, look at Nullsoft MPEG Audio Decoder
3.5. This is what decodes your MP3s so Winamp can play them.
The first tab lists “Full file buffering”; set this to a high value if
you want your MP3s to be placed entirely in RAM and play from
there. This setting is useful if you have a lot of RAM. Then
there’s the option between logarithmic and linear for the
equaliser. “Logarithmic” (the default) is the opposite of “expo-
nential,” and means that increasing a certain frequency boosts
it by just a reasonable amount. Setting it to “linear” will enable
more drastic playing around with the equaliser settings—setting
a particular control higher will make more of a difference than
if it’s set to logarithmic.

Winamp, like Windows Media Player and RealPlayer, has an
inbuilt Media Library that holds all your music. Rather, it keeps
track of your collection. From the menu on the left, you can book-
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mark items just like in a browser, view recently played and most-
played items, and so on. (Winamp keeps a track of what you’ve
been playing!) At the top, you can search for items in the library.
Here, explore the “Metadata reading settings,” even though it’s
been reported to be buggy (as of now). This is a button at the bot-
tom of the Watch Folders tab. Metadata is added to files by certain
programs, for example iTunes, and is basically information about
the file such as album and length and so on. Once you press
Configure, the options are self-explanatory—you can, for example,
choose to “smartly” detect metadata such as track number, artist
and title. This is useful when you have too large a music collection,
and don’t want to go through each song and manually look at
what it is. So if you’ve synced with someone else’s iPod (yes, you
can sync devices to Winamp), it can display song information you
haven’t even entered.

Talking about song information, when a song in the playlist is
in focus, pressing [Alt] + [3] takes you to the ID3 tag information
window for the song. If you downloaded a song, you’ll probably see
information about the song here, such as artist, album, and so on.
If you ripped a CD of yours, the information can be automatically
entered here by your CD ripping program if you’re connected to
the Internet, and choose something like “Enter information from
CDDB” in the ripping program. CDDB is a database on the Internet
that holds information about almost all commercial CDs, and it’ll
seem like magic at first—all information about the songs in your
CD comes is automatically entered into Winamp!

Of course, if you didn’t use the CDDB option, or if a down-
loaded song doesn’t have any information associated with it,
you can manually enter the information in the fields in the ID3
tag window. It’s a good idea to have your songs marked up this
way, because they become easier to search through via the
Media Library.

If you want songs to play continuously without a gap, here’s a
way: go to Plugins > Output > DirectSound output (or waveOut, as
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the case may be), and click Configure. What you need to change is
the “Buffer-Ahead on track change.” If you set the Buffer-Ahead to
5000 ms, Winamp will begin reading the next track when the cur-
rent track has five seconds left, allowing for a smooth transition.
If, however, your computer is low on memory, you’re better off
leaving this setting at the default.

Another interesting setting here is Fading, in the Fading tab.
It’s irritating to have a song end abruptly, and you can control that
here. There are too many options for us to discuss here, but suffice
it to say that you can control every aspect of fading you can think
of—including whether or not to fade while you’re seeking, that is,
moving the slider to a part of a song!

The options under Other in DirectSound (or waveOut) output
are interesting. Here you’ll be able to remove the silence at the
beginning or ending of tracks—and you can specify what Winamp
interprets as silence. You can choose to have the volume control
behave in a smooth manner, and you can choose between a loga-
rithmic and a linear volume control. This is similar to the loga-
rithmic/linear choice for the equaliser we talked about.

Winamp has SHOUTcast support, and can ably act as your
SHOUTcast client. SHOUTcast is free Internet radio—visit
www.shoutcast.com: there’s all the genres you can think of, and
when you click on a result with Winamp on, it just plays! You can
be a broadcaster as well—check the documentation on the main
page for details. Of course, you can also use other media players to
listen to SHOUTcast streams.

Coming to the plugins: like we said, they are divided into six
categories.

1. Input
These are decoders for various formats. If you find a format
Winamp doesn’t support, you’ll probably be able to find a plug-
in for it. 
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2. Output:
These control how sound is output by Winamp.

3. Visualization:
There are almost too many of these, and they are for what plays on
the screen while music is playing. To get a feel for what a visualisation
is, turn on the visualisation that comes with the player (“Winamp
Full,” available for free from winamp.com), and then look at the
reviews and download what you want from the “Visualizations” cate-
gory on the plugins page (www.winamp.com /plugins).

4. DSP/Effect:
These change the way your music sounds. You’ll need to experi-
ment with the various plugins available—just click the “find plug-
ins” button on the DSP/Effect page.

5. General Purpose:
Miscellaneous plugins.

6. Media Library:
Plugins for Winamp’s inbuilt Media Library.

3.2 Windows Media Player

One of the most popular media players around, probably because
it’s bundled with Windows. Here’s a look at its most important fea-
tures as far as audio is concerned.

You’ll see five tabs at the top of the player—Now Playing,
Library, Rip, Burn, Sync, and Guide. When you click Now Playing,
the window will display the video that’s playing, or a visualisation
if you’re playing an audio track.

Notice the green button with a down arrow. Here, you can
select visualisations, “enhancements,” and plugins. Under
Visualisations, you can choose from one of the inbuilt visualisa-
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tions, or choose to download one. Under Plugins, you can choose
to download plugins for WMP, just like in Winamp—clicking on
Download Plugins takes you to the Microsoft page where you can
download them. We encourage you to click the button and take a
look at what’s available. As an example, there are DSP plugins that
can enhance your listening experience, such as DFX 6, which
“enhances your listening experience with features such as ambi-
ence, stereo imaging, 3-D surround sound, dynamic gain boosting,
hyperbass, and headphone optimisation designed to make audio
at any bitrate on any computer sound best.” This particular plugin
is not free, but you can find free plugins as well.

Under Enhancements, when you click Show Enhancements, a
new pane opens up at the bottom of the window. Here you get sev-
eral options that add effects to the music or video being played.
There’s “SRS WOW Effects”, which you’ll need to experiment with
to get a feel of. You can also specify the kind of speakers you’re
using so that the effect works best. Then there’s “Crossfading and
Auto Volume Leveling”.

The Now Playing tab in Windows Media Player shows what’s being played. You
have your playlist at the right, and the other tabs at the top—very convenient
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Crossfading delivers a smooth transition between songs as the
volume at the end of the first song fades out and gradually goes
down, and the volume of the next song fades in and gradually goes
up. (Crossfading is available only when you play WMA and MP3
files that are either in your library or on a data or HighMAT CD. It
is not available with audio CDs.)

Often, when a new song begins playing, you need to adjust the
volume because the new song is much quieter or louder than the
previous song. The Auto Volume Levelling feature makes the
Player automatically adjust the volume. The Player levels, or nor-
malises, the volume by reading a volume-levelling value in a file,
and then adjusting the volume accordingly during playback.
Volume levelling is only available with files that are in Windows
Media or MP3 format, and that contain a volume-levelling value.
This value is automatically added to the files that are created
when you rip music from CDs. You can also add this value to files
on your computer that you have added to your Library. (More on

The Linrary tab in WMP shows the contents of your Media Library. The Media
Library, as in other players, is a great way to keep your collection organised
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the Library later). To add a volume levelling value to files you add
to your library, press F3 in WMP. The “Add to Library by Searching
Computer” dialog box will be displayed. Click Advanced Options,
and then select the “Add volume levelling values for all files
(slow)” checkbox. The next time you add files to your library, any
files that are in the Windows Media or MP3 format will have the
volume levelling value added to them.

The next item in the Enhancements is the graphic equaliser.
There are, of course, presets available. Then there’s the Play Speed
Settings: you can actually adjust the speed of the music playback!
Finally, there’s “Quiet Mode,” which you might want at night—you
can choose to have less of a difference between soft and loud
sounds, so that there are no sudden eruptions of volume.

Coming back to the tabs at the top of the player, the next tab
is the Library tab. You’ll find a button called “Add to library” at the
bottom left—clicking it will display a list of options by which you
can add music (or video) to your Library. Once you’ve populated
your Library, you’re ready to take advantage of several features.
Right-click on any item in the Library to see the options available.
Just an example here: you can rate items in the Library. This is use-
ful in a context we’ll come to soon.

Look at the button between the Now Playing and Library tabs.
When you click it, you get several options of what to play. You can
select by Album, Artist, Genre, and from the playlists you created.
You can also choose from an Auto Playlist—these include, for
example, songs you rated high, high-bitrate songs, and many
more, which is a very useful feature indeed.

And, of course, while you’re at the Library tab, you can search
for items in the search box.

The next tab is Rip: this, of course, is for ripping tracks from
CD. You can obtain information about the album from the
Internet via a button at the top right that says “Find Album Info”.
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Then there’s the Burn tab, where you add items to burn to optical
media, including DVD. Just click the Edit Playlist button at the top,
and add the items you want.

The final tab we’ll talk about is the Sync tab. Here, you can
sync music with your portable device. Of course, the device must
first be detected by Windows. Two panes appear under this tab—
on the left is the files in your library that you want to sync, and on
the right are the files on the device.

As an example of how to use the sync option, you can create a
“Partnership.” In a partnership, content can be synchronised auto-
matically or manually between your Library and one device. WMP
supports up to 16 synchronisation partnerships, which means you
can synchronise content in your library to 16 different devices that
you connect to your computer.

When you connect your device to your computer for the first
time, WMP starts the Device Setup Wizard, which helps you create
a partnership between the Player and your device. When you estab-
lish the partnership, you must specify whether content in your
library will be synchronised to your device automatically or man-
ually. When you connect your device to your computer after auto-
matic synchronisation has been established, the Player and the
device begin synchronising the content you selected, until all the
items are synchronised. If you specified manual synchronization,
then every time you connect your device to your computer, syn-
chronisation will not start until you select the content and speci-
fy the order in which it is synchronised.

If you connect a device that already has a partnership to a dif-
ferent user’s library, the Device Setup Wizard offers to use the
device with the new library for the current session, or switch the
device’s partnership to the new library permanently.

What we’ve talked about should give you an idea of how pow-
erful WMP is, and how useful it is for managing large music col-
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lections. There are many more features, of course, and as always,
we encourage you to explore all the menus!

3.3 Real Player

Another very popular media player, Real Player has an interface
that is similar to that of Windows Media Player, except, obviously,
for the colours. As in Windows Media Player, there are tabs at the
top for the common functions—Now Playing, Real Guide, Music &
My Library, Burn/Transfer, and Search. The interface is slightly
more intuitive than that of Windows Media Player, and the fea-
tures list is very similar.

The Music & My Library tab shows you your music collection,
and here’s where you add files to your library. The options here are
similar to those in Windows Media Player—after you’ve added files

The video window in RealPlayer. The interface, in general, is similar to that of
Windows Media Player
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to your Library, you can browse by artist and genre. You can rate
your music tracks, then build playlists based on such parameters
as your rating, the bitrate, and more.

The “Radio” button on the left brings up Real’s Internet radio
station directory. Clicking on “CD/DVD” allows you to burn a CD
after adding tracks to be burnt in the main pane. While here, the
Tasks pane opens up, allowing you to print a jewel case and more.
There’s no DVD burning option, though.

The menu options at the top are straightforward enough. For
example, the Favorites list shows you the bookmarks you’ve creat-
ed—for Web pages, audio, radio and video.

Synchronisation works pretty much the same way as in
Windows Media Player. Synchronization compares the content of
My Library and the active (attached and selected) portable device.
If the active portable device is missing any files, RealPlayer will
download the necessary copies to the device. Synchronisation
can be performed manually or automatically: to synchronise a
device manually, select Synchronize Device from the sidebar in
the Burn/Transfer page. To allow RealPlayer to automatically syn-
chronise files, first select Change Options... from the sidebar to
open the Options dialog. Next, select the Synchronization tab,
and then select “Enable automatic synchronization...”
Thereafter, whenever a portable device is attached to your com-
puter and RealPlayer is running, RealPlayer will synchronise My
Library with the device.

Help happens to be both online and offline: some items in the
Help window will only show up if you’re online.

RealPlayer, like Winamp, is skinnable—there is a default set
of skins available, and you can download additional skins.
Similarly, there is a default set of visualisations, and you can
download more.
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Under the Real Guide tab, you have sub-tabs called Video,
Radio, and Games. Under Video, you get movie trailers and such,
under categories such as Most Watched and under various genres
such as Comedy and Thrillers. You can play the trailers for free,
but there’s also a link called “Play Full Video”—this is a 350 Kbps
streaming clip—but to watch this, you need to be a paid member
of SuperPass. We don’t know what you’ll get to watch here because
we didn’t sign up, but in any case, since it’s highly unlikely that
you have a 350 Kbps connection, it doesn’t matter!

The Radio tab gives you lots of free radio stations. Listed are the
station name, a brief description, genre, bitrate (so you can choose
one that your Internet connection can support), country from
where it’s being broadcast, and language. And you can search by
genre, language and country. The few stations we tried played
wonderfully, so we suspect only stations that stream well get
included in the Real Guide.

The Music & My Library tab in RealPlayer. By placing tabs such as Music Store
on the left, RealPlayer incessantly urges you to visit their sites—and shell out!
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Under Games, you get various games to download and try—you
get a short description of the game, a free download link, and a
full version download link (for SuperPass members only, again).

The address bar at the top isn’t just for download links and
radio station addresses—it’s for any address, so RealPlayer can act
as your browser as well!

Under the Search tab, you have two tabs: “Web” and “Audio/
Video”. “Web” is basically Yahoo! Search. Under “Audio/ Video,”
you can find and play thousands of free audio and video clips, and
what’s currently playing in Real.

Each search result is displayed as follows:
❍ An icon that shows whether it’s video or audio
❍ The title of the search result
❍ The time in hours, minutes and seconds
❍ The category the clip falls under—such as “Television,” “Other,”

“Radio,” “News,” “Finance,” and so on
❍ The bitrate of the clip (don’t be too ambitious—but there are sev-

eral 28.8 and 56 kbps clips as well!)
❍ A description of the clip
❍ The URL of the clip

You’re also invited to “Visit RealOne Radio to tune into your
favorite stations,” which takes you back to the Radio page we
talked about earlier.

The link to the right of Help at the top of the RealPlayer win-
dow—the “envelope with wings” one—is the Real Message Center.
From the Help, “Message Center is a software application that
alerts you to content clips specific to your interests.” So how does
Message Center work? You sign up for topics. Message Center will
then occasionally check with RealNetworks’ Message Service for
new messages and downloads them. Message Center notifies you
at which point, you can open it to view these messages. Within
each message is a link you can click on to initiate play back of the
associated story.
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Basically, RealNetworks editors “search the content they work
with and package the most interesting clips into messages for
RealPlayer users.” It’s free.

Well, that sounded a little bit like spam and a little bit inter-
esting at the same time, so we clicked on it. We got an option to
“Customize messages” and also one to download them.
“Customize messages” brought up “Coming soon”—so there seems
to be no way to customise your messages as of now. When we
downloaded the messages, we saw eight messages with eclectic
content—some of them links to trailers, a couple of them called
“Best clips of the month”—you get the idea. In all the messages is
a link to Rhapsody, another service of RealNetworks. (Rhapsody, by
the way, is something you need to download; it includes a music
organiser, and it seems to be a paid service, because you can play
25 full-length songs a month for free, while you have a choice of
1.5 million songs. Visit www.real.com for more.) The messages
weren’t personalised in any way, and we suspect there’ something
here about what you specify when you download or install
RealPlayer. We advise you to customise your preferences at your
Real.com account, such as “demographic data.” One way to get to
your account is to click on the SuperPass ad and then under “More
Info”, click on “My account.” Use the e-mail address and password
you used when you downloaded or installed RealPlayer. 

A word about SuperPass: if you sign up, you'll get the full-featured
RealPlayer Plus, and you can
❍ Watch full-length movies and videos 
❍ Download full-version games 
❍ Access a comprehensive radio guide to 5,000+ stations 

Though the service is $6.95 (Rs 325) per month, you can try it
free for 14 days.

The “Globe” icon at the extreme top right of the RealPlayer
window has a drop-down. The following are the items in the
drop-down:
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❍ RealGuide, which takes you to the same RealGuide page we
talked about earlier.

❍ Music Store, which doesn’t seem to be accessible at the time of
writing

❍ Music Guide, which looked to us the same as the Video tab we
talked about earlier

❍ Rolling Stone, which takes you to www.rollingstone.com, an
entertainment site

❍ Radio, the same as the Radio tab we talked about
❍ My Library
❍ CD/DVD, to burn or play a CD or to play a DVD
❍ Burn/Transfer, for burning CDs and syncing with your portable

device
❍ Search, which opens the Search tab we mentioned
❍ Web, which opens up the Web browser

With its integration of all things music-related, RealPlayer is a
comprehensive package. You really don’t need to leave the player
if everything you’re doing at your computer is entertainment-
related. But there are three gripes we have. The first one isn’t
Real’s fault: we need broadband to enjoy all the free content out
there! Second, there’s no DVD burning, as opposed to Windows
Media Player. And third, when it comes to just playing your stored
music, you have greater control over the way your music sounds
with Winamp: even the equaliser and crossfade are paid in
RealPlayer!
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Yes, we know most of you get your music from CDs burnt on your
friends’ computers, or directly from their hard disks! This is

illegal! According to several sources, a CD is to be treated “like a
book”—only one person should have it at any time. So sharing CDs is
not illegal, but recording them to your hard disks as MP3s and then
copying them from PC to PC is.

Get Your Music 
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If you want to go legal, there are sources on the Internet for
MP3 music. There are many MP3 sites that offer classical music
(because so much of it is non-copyrighted), and at the other end of
the spectrum, there’s lots of music from bands you may not have
heard of (because the artists want to promote their work). Here are
some online music sources.

4.1 Legal MP3 Downloads

http://music.download.com/
Download.com—the music section, that is—claims it’s the “pre-
mier source for free music,” and also claims more than 75,000
MP3s. Of course, there’s a search bar on top, and you can search by
artist or song. 

www.emusic.com
You get 25 free MP3s, but you need to register for this. Songs are as
little as 25 cents (Rs 11) after the free trial. The plans go like this:

eMusic Basic: 40 downloads per month; Free 14-day trial, then
$9.99 per month

eMusic Plus: 65 downloads per month; Free 14-day trial, then
$14.99 per month

eMusic Premium Best Value: 90 downloads per month; Free 14-
day trial, then $19.99 per month

www.ecbrown.org/linkpage.htm
A vast page of links to free MP3s—an eclectic-looking site; there
doesn’t seem to be much structure here—but you can poke around
and find a lot of MP3s!

www.oddiooverplay.com
“This website exists to spread some happiness all over the planet
by connecting you with fantastic artists who deserve to be heard,”
they say. The site is well-organised—a rarity amongst all these free
MP3 sites—and on the left, you’ll find Internet radio as well. The
MP3s aren’t on the front page for you to look at and download
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though—a click here, then one there, and so on, until you stumble
upon downloadable MP3 links!

www.elkysearch.com
This site happens to feature a pod-
cast. In the main search window,
the “random” button doesn’t seem
to work. We typed in “Metallica”
and got a “suggestion”: “stealth-
sonic...” and upon clicking that,
we got to three working MP3 links.
You can help by reporting broken
links wherever they exist, via a
link right next to each download link. The collection here seems
to be broad but small.

www.amazon.com
Yes, beloved amazon.com does have a free MP3 downloads section!
In the search box at the top left, just choose “Music downloads”
and your keywords. Of course, chances are you won’t find what
you’re looking for, because only non-copyrighted songs are free for
download. But if you’re a classical listener, you’ll find some music
here, and also if you want to listen to new artists in various genres.
(“Metal” produced 12 results.) Well, just milk the site for whatever
you can get for free!

www.mp3.com
At MP3.com, you can stream a lot of songs without hassles. You also
get bleats for money, but you can listen to previews before you shell
out. But even clicking on “free music” takes you to a place where,
well, you can only stream music—but here, it’s entire albums you
can stream. There seem to be no free downloadable MP3s here.

www.mp3.com.au
Now this one is better-designed than mp3.com, with the search,
genres, browse, etc. links rather neatly arranged. Explore and find
your way around, and presto—downloadable MP3s!
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www.archive.org/audio/etreelisting-browse.php
A huge archive. Click on an artist... click on a year... go to the down-
load link... and you’re presented with something called a “batting
average,” under a heading called “Download Show.” Beneath that is
a “Help with downloads” link—you’d do well to click that one.
Clicking on “individual songs” takes you to a list of downloadable
songs in .shn format, which seems to be an uncompressed format
we hadn’t come across thus far. You’ll have to convert the .shn to
mp3 or any other format yourself, using any of a variety of freeware
tools such as MP3 CD Converter from www.mp3-cd-converter.com.
Note that this is not a recommendation, just a pointer. Search for
.shn to .mp3 converters yourself—and you just might find freeware.

www.soundlift.com/browse/music.php
Refreshingly simple. Select a genre, select a track, and hit Download.
You can also stream the music. The number of genres is limited
though—prominent amongst them are blues, jazz, soul and swing.

www.remixwars.com
The genres here include Ambient, Electronica, Futurepop, Gothic,
Industrial, Noise (yes), Synthpop, and other exotic ones we’ve
never heard of before. Anyway, we went to Industrial, clicked on an
album, and were taken to a download page, but it turns out you
need to have a (free) account with them to download songs. Go
ahead—if you like “Noise,” register!

www.asianclassicalmp3.org/index.htm
“The music on these Web pages is all from recordings, most often
cassettes, that are either out of print, only available in the country
of origin, or both,” the site declares. There are a few countries list-
ed—such as Burma, Cambodia, and, yes, India. Four links under
“India.” Downloadable MP3 links!

www.goingware.com/tips/legal-downloads.html#websites
This is a site full of links. We can’t guarantee the legal status of all
the links mentioned here, but the page is worth a look and a sub-
sequent dig-around.
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www.blentwell.com
If genres such as “bail funk” and “ghetto tech” and lots more are
your kind of music, don’t miss blentwell.com. Freely download-
able MP3s.

www.classiccat.net
A vast collection for classical music lovers. If you select a compos-
er and a work, you’re taken to a page that lists pages you’d like to
visit, for example, from where you can purchase the CD. There
seem to be no direct download links; the ones that do exist redi-
rect you to the page where the music can be downloaded. We tried
one; it took us to a page that listed the performer’s works. And
found lots and lots of downloadable tracks in RM, WMA and MP3!
There’s no direct search-to-MP3 mapping, so consider this site as a
starting point for a classical music download search.

www.classicalarchives.com
A near-nightmare of a front page - garish and intimidating. But this
text is prominent: “The Classical Archives is the largest classical
music site on the Web: 37,815 full length classical music files by 2,018
composers. If you are new to the Classical Archives ™—PLEASE READ
THIS!” Read that you should. Subscribers can access 1,000 files per
month (100 per day), including all protected files such as hi-fi MP3s
and concerts. Registered free users may access five unrestricted files
per day—excluding hi-fi MP3s and other restricted files. Registration
is free; a subscription is $25 (Rs 1,200) per year. Good enough.

http://epitonic.com
Go to album page. Check for available MP3s from album.
Download. Or add to playlist and stream. Plenty of external links
to artists’ pages.

http://freesologuitar.com
A very small site, worth a one-time visit for acoustic guitar fans.
Just visit the site and grab all the MP3s. Straightforward down-
load links.
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www.bestmp3links.com/hindi-song.html
A collection of links ostensibly to free MP3 download sites. We
clicked on a few. Some worked, some didn’t. Check out all the
links and you might end up with some good Hindi MP3s.

www.insound.com/mp3/mp3s.php
Rather a large collection—many tracks for free download. The site
is well-organised, too. Individual tracks are downloadable—osten-
sibly as teasers—and albums can be bought.

www.isound.com
This site has tracks for download, radio, and blogs. Clicking on an
artist’s name and then on an album takes you to a link where you
can buy the CD - bummer. But there is a free MP3s section as well.
A decent-sized selection.

www.karadar.com
Karadar Classical Music seems too
good to be true (as far as classical
music listeners are concerned)—
there seem to be thousands of
tracks available for download!
There’s a hitch, though. You click
on the download link, and pop
comes up a window sans any
clickability. A seeming dead-end.
But we tried the same thing on
Opera, and there was a visible
clickable element—clicking that
led us to a registration page. After registration, you can collect the
music you want and put it in a sort of portfolio, and download the
entire selection at once. Something really funny is that before you
download your tracks, you’re asked an easy classical-related ques-
tion. If you get the answer wrong, you can’t download! The
“Purpose of the Question” is stated on the site—doesn’t make any
sense to us, though.
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Oh, by the way, you need to click on the “MP3 Archive” link on
the main page for “11,000 free MP3s.” And be warned: downloads
are very slow. If you’re on dial-up you’re fine; if you’re on “broad-
band,” prepare to be frustrated.

www.salon.com/ent/audiofile/index.html
“It’s been offline a little while for maintenance, but the
Audiofile archive of Thomas Bartlett’s selection of the Web’s best
free downloads is back. You can browse alphabetically through
hundreds of songs...” The site seems to get updated every once in
a while with new additions. You can browse by artist. A some-
what limited collection. 

www.smart-music.net/mp3.html
An average-sized collection of dance music by new artists. You can
stream, buy albums, and download MP3s. There’s also a radio sta-
tion. They “offer some help for music-lovers... search the web for
the finest and free dance music available.”

http://onlinetonight.net/mp3
“Helping you legally download digital music that rocks: a service
of Online Tonight and The Net Music Countdown with David
Lawrence.” The site is a music blog, and seems to be updated reg-
ularly. Lots of podcasts available for download as MP3s.

www.eclassical.com
A fantastic site for classical lovers—great music at great prices.
Single tracks as well as albums available. Entire albums are avail-
able for as low as $6 (Rs 280)—and single tracks for as low as $0.79
(Rs 37). A large selection to choose from.
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4.2 Legal Torrents

BitTorrent isn’t illegal by itself—it depends on what you download.
There happen to be a few (but only a few) legal torrents around.
Browse through www.legaltorrents.com/index.htm and
http://bt.etree.org/ to find some.

4.3 Internet Radio

We mention here only a couple of the large Internet radio portals,
and a couple that have comprehensive sets of links. Some portals
give you links to the radio pages, and some have “inbuilt” player
windows. In many cases, you'll need to have RealPlayer installed.

Remember that (as for any Internet radio station) you’ll need a
“broadband” connection for the good sound! If you don’t, there
still is hope—you can find low-bitrate streams, too. A day of explor-
ing the Web and you’re bound to come up with a bunch of stations
that can keep you musically entertained 24x7 on a dial-up con-
nection as well.

www.shoutcast.com
Almost all popular genres.
Free. You can also set up a
radio server if you want—
but we doubt you have the
bandwidth! You can
browse stations by genre,
search for stations or gen-
res, or browse through the
near-650 pages of stations!
You can also search by
genre and bitrate (a cool
feature). Just tune in, and Winamp will open (by default).
Remember that (as for any Internet radio station) you’ll need a
“broadband” connection for the good sound! If you don’t, there
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still is hope—you can find low-bitrate streams, too. A day of
exploring the Web and you’re bound to come up with a bunch
of stations that can keep you musically entertained 24x7 on a
dial-up connection.

www.radiofreeworld.com/page14.html
This is a directory. There’s everything from “Refreshing, soothing
music at your computer 24 hours a day” to
“Electrohumantransmissions” and “Radio guide for Florida Keys
and South Miami.” Take your pick. Here we tuned in to www.
relaxradio.com, which is worth a mention. 

www.live365.com/index.live
The big daddy of Internet radio portals. Lots and lots of genres
and stations.

www.radiotower.com
Seems to have a large collection of stations. Looks like you need to
subscribe, though—and you’re going to get more spam if you do,
no matter what they tell you. But here’s where we found xlnc1.org,
which is worth a mention.

www.radio-locator.com
Claims to be “the most comprehensive radio station search engine
on the Internet.” They “have links to over 10,000 radio station Web
pages and over 2,500 audio streams from radio stations in the U.S.
and around the world.”

As a note, we should mention that you can record any audio
stream courtesy a number of software players. One such is Zinf
audio player, which lets you record to MP3. To download it for
Linux or Windows, visit http://zinf.org.



Section II

Make
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The Basics of Editing

Now that you’ve learnt how to get yourself ready for music, you
will find yourself getting more involved in a little advanced

stuff. Except for the musicians amongst us, not many of us can make
our own music, but we sure can edit and change our collections to
suit our needs! Let’s start with the basics of editing.
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5.1 The Rig And The Software

Before we start, a little diversion to explain what software and
hardware you need. 

If it’s basic audio editing you want to try your hand at, you’d
be relieved to know that the software is much less demanding
than you might imagine. You could start off with as little as a
Pentium III with 128 MB of RAM! 

Ultimately, it’s what you’re going to do with your PC that’s
going to decide what it’s going to contain. The first essential is
hard drive space. Audio editing software likes to work with
uncompressed audio, so a three-minute MP3 that would otherwise
occupy around 3 MB of space will now be decompressed to about
30 MB in your temporary folder. If you’re going to load multiple
files (and you will when you’re mixing audio files), you could find
your hard drive filling up faster than Bill Gates’ piggybank, so
make sure you have plenty of free hard drive space for your soft-
ware to use for temporary storing of uncompressed audio. Ideally,
you should use a separate hard disk for this altogether (the audio
editing program will let you choose a temporary folder), and
preferably a fast one.

The next order of business is the processor. Applying effects to
audio files will take considerable number-crunching power, but
even a good old PIII can survive it if you’re not going to be apply-
ing them real-time—that is, if you’re prepared to select an effect,
wait while it gets applied, and then undo if you don’t like it.
However, if you plan to mix karaoke numbers and process sound
while it plays, you’re going to require at least a Pentium 4 at 1
GHz. You’ll also need a respectable amount of RAM—at least 512
MB for real-time processing. 

Our recommended configuration:
❍ Windows XP
❍ 1.4 GHz Pentium 4 or equivalent Athlon processor
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❍ 512 MB RAM
❍ At least 3 GB free HDD space

(after you’ve installed the audio editor)
❍ Display card capable of a resolution of 1024 x 768 @ 32-bit colour

(for those expansive consoles that software today sport)

Now that we’ve got the rig set up, it’s time to kit it out with some
of the meanest audio editors on the market. 

Among the freebies, the only two worth mentioning are
Audacity and WaveLab. We introduce Audacity in §5.5.

WaveLab
WaveLab by Steinberg Audio
is actually a full-fledged paid
tool, but you can download a
stripped-down free version
too. Another winning tool, it
has a robust and intuitive
interface, making it very
beginner-friendly. This, too,
supports third-party VST plu-
gins, so you’ll never tire of all
the effects you can have in a single package. 

WaveLab has been touted as one of the quickest batch proces-
sors on the market, applying effects and filters to multiple files in
a flash. It even lets you author your own audio, data, or hybrid CDs
from within the program itself, including designing CD covers
and graphics. The Audio Database, a much ignored feature in the
software, lets you organise your sounds and music into cate-
gories—something that will be a lot of help if you have a huge col-
lection of sound bites and loops that you’ll use often. 

Adobe Audition
A good while back, there was a program called Cool Edit Pro that
did some wonderful things for the way people looked at sound
editing. No more was it the domain of the sound engineer—even

Steinberg’s WaveLab
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your average PC user could re-
master audio in a snap. With
its extremely easy-to-use inter-
face and gaggle of effects—
both fun and for serious audio
cleaning—Cool Edit Pro swiftly
gained ground as one of the
most popular audio editors of
all time. Not only was it an edi-
tor for individual files, you
could also use the multi-track editor to create your own audio
mixes with ease and immense control.

And then a company called Adobe Systems bought
Syntrillium—the company that developed Cool Edit Pro—and
rechristened Cool Edit Pro Adobe Audition. Since then, Adobe has
been taking Cool Edit Pro to new heights, keeping it at its glorious
Top-5 position. Support has been added for third-party VST and
DirectX plugins. Adobe also somehow managed to bloat the
installer from a very humble 20 MB to a gob-smacking 470 MB. It’s
also a bit heavier on system resources than the original.

If you love the features (and you can’t help but), you could
download the old Cool Edit Pro as well by searching for it on
www.softpedia.com.

Sound Forge
Sonic Foundry’s Sound Forge
(now Sony’s) is another con-
tender for top spot for audio
editing. It, too, sports an easy-
to-use interface, though it’s a
bit daunting at first. It’s one of
the most robust tools we’ve
seen—recovering from a crash
is hardly an issue, because there are always crash recovery files
that come to your rescue. It works brilliantly with sound cards and

Adobe Audition

Sound Forge and CD Architect
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now even supports burning of full CDs, thanks to the bundling of
CD Architect.

Unlike Adobe Audition, though, Sound Forge doesn’t come
with a multi-track editor—it’s purely for editing and re-mastering
audio: a good thing, because it gives Sound Forge focus, and ren-
ders it an extremely powerful workhorse for sound editing.

5.2 Why Editing?

Now, you might be wondering, “Why would I want to edit any-
thing?” You’re probably pretty happy with your 2 GB collection of
favourite songs, as well as that 1 GB you don’t like but can’t get
yourself to delete! Well, as right as that may sound, it couldn’t be
more wrong!

Let’s take the example of an average music collection. You have
a folder where all your music is stored, and have playlists nice and
organised in your favourite media player, but you can never get too
far from your PC, or be away for too long, because all the songs have
different volume levels! So even though you’d like to sit back, kick
your feet up and just enjoy your music, every now and then you’re
forced to sit and stare at the computer, increasing or decreasing the
volume and/or equaliser settings to try and make that song sound
just as loud and full of bass as the last one that played!

Worse, when you record your music collection from tape or
vinyl (see chapter 7 for more on recording audio)—more often than
not, you’ll find flaws like muted highs and overdone lows, and the
worst of them all—noise that makes music sound like it’s being
played through a waterfall.

5.2.1 So What Do I Do?
The short answer? Edit the music!
What you’re doing when you change a music track or loop is edit-
ing. Rather than doing it every time you play the track using the
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volume and equaliser settings, you can do it once and for all by
editing the song.

The most basic type of editing is Normalising. In plain terms,
normalising audio is the act of amplifying it so that the loudest
point on the waveform is just under the maximum output level.
Basically, it’s just amplifying the waveform as much as possible
without clipping (see §5.7 for more on clipping).

If you use Windows Media
Player 10, you can try and get
all your music to have the
same volume level by choosing
the right setting when adding
the music to your library.

As you can see in the
screenshot, just check the
“Add volume leveling values
for all files (slow)” and then
import all your music. Though this will take considerable amount
of time for any collection over 1 GB, you can (and should) just leave
it while it imports. Here’s one perfect example of how patience can
pay off in the long run. 

If you prefer some other media player, look for a similar vol-
ume levelling setting, which may also be called “Normalize.” 

However, if you want a more permanent change, and wish to be
able to play all your music in any media player on any computer or
even a portable device, and do not want spikes and dips in the vol-
ume levels, you can edit the songs using an audio editing software
such as the open source Audacity, or Adobe Audition.

Use Windows Media Player to import all
songs with automatic volume levelling
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5.3 Decibels, Frequencies, What?

If you’re going to try your hand at editing and splicing and mixing
tracks, you need to have the basics right. For starters, you need to
know some of the terminology and jargon you will find when edit-
ing. Since there are thousands of terms used in this field, we’ll just
stick to explaining the terms you’ll come across when dealing
with Audacity.

Amplify: When you change volume levels, you’re amplifying
the sound. In general sound terms, this could be the act of con-
necting a musical instrument to an amplifier that can increase
the volume by a multitude of levels. In Audacity, amplification
increases or decreases the amplitude of the waveform.

Bass: Sounds of lower frequencies are called bass sounds. The
word is often mispronounced to sound like “bahs”; the correct pro-
nunciation is “base.”

Bass Boost: The Bass Boost effect raises the lower frequencies
in a song to add more thump to the song.

Compressor: This is an effect you will come across in Audacity.
What it does is soften the louder peaks of a song while keeping the
softer peaks the same (as seen in the waveform, that is). Thus you
get very little variation of loudness in a song. Try it on a song you
know well and see the difference. Most often it will ruin a song,
and should only be used on parts of a song where a particular
instrument is accidentally getting drowned out.

Crackle: In audio, crackle is a sort of noise or distortion heard in
tracks—much like the interference that a lot of us have become used
to while using our cell phones. It can be best described as the sound
that’s first emitted from two-way radios (walkie-talkies) when the
transmit button is pressed. Obviously, these are much-unwanted
noises in audio, and filters need to be used to remove them.
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Decay: When a sound grows noticeably softer with time, and
finally dies out, it is said to be decaying. This is mostly used in
an effect called Echo, where a sound needs to grow softer after
every echo.

Decibel: Written as dB, this is a logarithmic measure of the loud-
ness of a sound or power of a signal. The human ear, for instance,
hears the faintest whisper at around 1 dB and feels ear-splitting pain
at around 130 dB—0 dB is eerie silence to most people (some people
have been known to hear the faintest of sounds at -10 dB). For a sound
to appear about twice as loud, and increase of about 6 dB is required.
Since the dB is a relative measurement, a 3 dB increase in signal
sounds like a 50 per cent increase in volume. Say a sound is playing
at 3 dB and you increase this to 6 dB, it will sound 50 per cent loud-
er than before, but it’s actually double the power being used to pro-
duce that sound. Increasing it to 9 dB would make it sound twice as
loud as the 3 dB sound, but it is now using four times as much power.
It’s a little complicated, and you should visit www.prorec.com/prorec
/articles.nsf/articles/EA68A9018C905AFB862 5675400514576 to get a
better understanding of how the decibel is calculated. Warning:
mathematics involved!

Echo: This is an effect where a sound repeats itself after a set
duration, much like the way your voice echoes in large, empty
spaces. In Audacity, a sound is “Echoed” by repeating it after a
specified delay and with a decay that causes the sound to become
softer with each echo.

Equaliser: This is the control that makes specific frequencies
louder or softer. For example, with the Windows Media Player
equaliser, you can control frequencies ranging between 31 Hz and
16 KHz (the human ear’s listening capabilities typically fall
between 20 Hz and 20 kHz). Of course, it’s not just these specific
frequencies that are controlled; the equalizer creates a curve
between the frequency controls and modifies all frequencies
according to the curve. Equalisers are often needed to tweak the
output of speakers in differently-spaced areas (open-air, indoors,
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crowded room, etc.), but you
can play around with the
equaliser to make the music
sound any way you want (in
terms of highs, mids and lows,
that is)!

Fade In / Fade Out: The
effect that’s normally at the beginning or end of a song. If a song
starts softly and then grows louder until it reaches normal vol-
ume, the effect is called Fade In. If a song goes from normal vol-
ume and gradually grows softer until it is inaudible, it is said to be
fading out. You can set your songs to Fade In or Out by using these
options from the Effects menu. 

Filter: Much like the dictionary meaning of the word Filter, in
musical terms, this is a device, effect or plugin that removes some-
thing from the sound that’s provided to it. Most commonly, a fil-
ter is used to cut out hiss and crackle in an audio track, but is also
used to single out frequencies to apply effects to them.

Hiss: Another form of noise in audio, hiss is most common and
audible when there is a break in a song, or when there’s any peri-
od of silence or soft music. The sound is called hiss because at loud
volumes, it ssssssoundss like there’sssss a sssssssnake in your
ssssspeakersss.

Noise Reduction / Removal: This is like a filter for hissing and
crackling, and attempts to remove such noises from an audio track.
The most common use for Noise Reduction is to remove the hiss
that occurs when there is silence in a song, or while an instrument,
such as an electric guitar, is powered up but not being played.

Pitch: This is something determined by the human ear, unlike
frequency, which is the measurement of vibrations per second.
Think of pitch as “frequency as heard by the ear”: women’s voices
are generally more “high-pitched” than men’s. Frequency is a

The Windows Media Player Graphic
Equaliser
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more accurate measurement of sound, and the difference
between, say, 440 Hz (the note A above the middle C in concert
music) and 441 Hz is not noticeable by the human ear. Thus,
though the pitch of two notes may appear to be the same, the fre-
quencies may not be.

Tempo: The speed at which music is played. If you listen to a
song carefully, you will find patterns in the beats, and this defines
the tempo of the song. If you speed up the beats, the tempo increas-
es. In Audacity you will come across ways to change the tempo of a
song, by either increasing or decreasing the pitch, or by keeping
pitch constant and increasing or decreasing the length of the song.

Track: Normally used as another word for song, but when edit-
ing audio, you can mix various songs by putting them in the same
file, but in different “tracks.” Here, tracks are merely a component
of a final output. Musicians always record each instrument and
vocal on different “tracks,” so that each can be tweaked individu-
ally and then mixed to get that perfect balance of sound.

5.4 Waveforms

The next thing you need to know about when you want to do a lit-
tle basic audio editing is how to read waveforms. This may look
and sound complicated, but is actually a lot easier than it appears. 

First of all, let’s take a look at a typical waveform of a song and
compare it to the waveform of a constant pitch—that is, a single
note playing constantly with the same loudness.

As you can see, music has a lot of spikes and dips in waveform.
Now, when editing this waveform, such as when cutting and splic-
ing, you need to keep two things in mind—tempo and amplitude.
It takes a trained musical ear to be able to tell the tempo of a song,
but you can do this too. When zooming into the waveform, watch
for patterns in it. Also, listen to the track as it moves through the
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waveform and try and get two repe-
titions of a beat to fit into your dis-
play. To simplify, listen to the
drums of the track. Listen for the
beat sequence or the rhythm of the
track. Once you have established a
pattern, try and zoom in to easily
fit two repetitions of that same beat
sequence. This is how you can
identify areas in the waveform
to edit (cut / copy / paste).

Let’s look at the intro to a song:
In this track, the intro is a sim-
ple drum beat, which repeats
twice before the other instru-
ments kick in. Though we loved
the song, we wished the catchy
drum beat would continue a little longer before the other instru-
ments joined in. Though the artists didn’t mean to make the song
that way, we decided we’d just make it the way we wanted it, with
help from Audacity.

First, as you can see in the screenshot, we zoomed in to the
right level to get the rhythm right. We then proceeded to mark the
area in the waveform that we wanted to repeat.

Here’s where you have to
make sure that you cut or
copy a waveform selection
from a point where the ampli-
tude is 0—that is, a point
where the wave meets the X
axis. The reason for this is
that at this point, for a very,
very short time, there is no
sound being emitted. Thus,

The waveform of a constant pitch

A waveform of a typical rock ballad

Copying part of a waveform from a song
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cutting at this point would not cause a sudden silence or cause the
pasting of this selection to make a noticeable pitch, tempo, loud-
ness and musical change.

Once you have marked
the selection, you should play
it using the spacebar. If need
be, make a new file and copy
and paste this selection into
that about three times. This
will make it easier to make
sure that the track or selec-
tion actually loops!

In our example, we copied the selection to a new file and past-
ed it thrice. After checking to make sure that the selection was cor-
rect, by listening to it obviously, and that it looped nicely, we
added it back to the original song. As you can see in the screen-
shot, the same song now has a drum beat intro that lasts three
times longer than before. 

These are the most basic
and fundamental things you
need to know before you
start editing audio. We urge
you to use some more effects
and functions in Audacity,
and remember to keep a
backup of the song(s) you’re
opening for editing—just in
case! Once you’ve mastered
the tempo and waveform
viewing, you’re on your way to full-blown audio editing.

Cutting the wave at the right spot

The final track has a 300 per cent longer
drum intro
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5.5 Audacity

Called “the GIMP of audio” by its growing community of fanboys,
Audacity is the free, open source underdog in the mean world of
audio editors, which has been dominated by paid software ven-
dors for a long time. It can edit most popular audio formats—MP3,
OGG, WAV and MIDI among others, and it also has a multi-track
interface that will let you mix tracks to create your own versions
of songs. It’s also very easy to use, and beginners will have no trou-
ble getting used to it.

Audacity comes with all the essential effects loaded—amplifica-
tion, time and pitch alterations, etc. (read more about these effects
in chapter 8), and supports the VST plugin architecture (you can
read about this, too, in chapter 8), which lets you keep adding more
VST effects that you can download. The Virtual Studio Technology
(VST) enabler is an interface that will allow you to connect your
musical audio output devices, such as a synthesizer or effects, to
Audacity for recording and editing. If you have a few musical instru-
ments or software effects, you should download the VST enabler. If
you’re only looking for very basic editing, such as cutting, cropping
and normalising tracks, there’s no need. We do, however, encourage
you to install it to give all the cool VST effects available a try—you
might just discover a new hobby in audio editing!

There’s no limit to the number or length of tracks you can load
into Audacity, and it supports unlimited undos too—meaning that
the only limiting factor here is how much free space you have on
your hard drive. You can get Audacity from http://audacity.source-
forge.net/; it’s just 2.3 MB. You will also need the LAME MP3
Encoder, which, too, you can find at the same site. This encoder
will let you edit and export files as MP3, and since most of us have
MP3 collections, Audacity is quite lame without LAME!

We proceed to explain how to use the normalisation and
amplification features in Audacity.
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5.6 How Normalisation Works

When normalising a wave,
the audio editor treats the
output range of your sound-
card as percentages—0%
means total silence, and
100% is the maximum possi-
ble sound output before clip-
ping (§5.7) occurs. You could
normalise your audio to any
percentage within this
range, meaning that no part
of the sound will cross that
level. So normalising to 80%
will ensure that even at its
loudest, the sound output
will never exceed 80% of the
maximum. Rather than offer
you percentages, some audio
editors will ask you to set a
normalisation using decibels.
The unit in play here is dBFS—
decibels Full Scale. The maximum (yes, maximum) value that you
should set this to is 0dBFS.

In most cases, normalising to 100% (or 0dB) will do the trick,
but you also need to consider whether the files will be used later
for any other audio editing work. If so, you should normalise to
about 95% (or -0.5dB) which should give you enough room to play
around with more effects.

Let’s now get to normalising a track using Audacity.

5.6.1 Normalising Using Audacity
First open Audacity, then choose File > Open, and select the song
you want to normalise. You should now see a waveform as in the

The before and after pictures of a
normalised waveform
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screenshot. Normalising a
track in Audacity automati-
cally sets the highest peak to -
3 dB. This ensures that there’s
no jarring and distortion
even at the loudest part of the
song—the highest amplitude.

Click anywhere in the
waveform and press [Ctrl] + [A]
to select the whole song. Now
go to Effects > Normalize…, and
click Preview if you want to hear a
few seconds of the normalised
track, or just click OK to
Normalize. You will see a smaller
waveform, with lower peaks, and
you will now not find distortion at
higher volumes.

The greatest advantage of the
normalising effect is that it
can be applied in batches (in
the editors that support batch
processing), so your music
collection will have a consis-
tent volume throughout. It’s a
standard feature in nearly
any application that has any-
thing to do with audio—you
might have noticed the
“Normalize All Tracks” option even when creating an audio CD
using Nero.

Normalising music files as a group works in the same way as
Normalise, only the peak of the wave is calculated by analysing the
loudness of all the waveforms rather than fixing it to an arbitrary

Opening a song in Audacity will show you
its waveform

Select Normalize from the Effects
menu to prevent distortion

Just click OK to normalise, or click
Preview to hear a few seconds of the
normalised track
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value you selected. Or, you can make
a list of songs that are noticeably
louder or softer than the rest of your
collection, and then use Audacity to
make the songs softer or louder, as
the case may be.

5.7 Amplifying And Clipping

As we mentioned above, when a track is too loud or too soft in
comparison to the others in your collection, you need to increase
or decrease the volume whenever it is played. To avoid this, you
can use Audacity’s Amplify effect. Though amplification is gener-
ally synonymous with increasing the loudness of a song, in
Audacity, you can use this effect even to make a song softer than
it currently is.

Open a track, use [Ctrl] + [A] to select all then click on Effect >
Amplify…, then move the sliders or fill in the value you desire. You
have two values to look at here: Amplification (dB), and New Peak
Amplitude (dB). Amplification is the amount in dB that you want to
increase or decrease the sound by, while New Peak Amplitude deter-
mines how loud the loudest sound in the song will be. If a song is
too loud, use negative values in the options to make it softer.

Another important thing to remember when using the Amplify
effect is the clipping we’ve been talk-
ing about. The audio amplifiers in
your soundcard and speaker system
do have a maximum output limit, and
once this limit is reached, your speak-
ers will be driven at their maximum
output until the sound level falls
below the limit again. To you, the lis-

Here’s the waveform for the
normalised track

A waveform suffering the woes of
clipping



V THE BASICS OF EDITING

86

DIGITAL AUDIO

FAST TRACK

tener, this means that you will
hear a very undesirable distor-
tion and crackling from your
speakers, not to mention risking
permanent damage to them.

To see what this looks like
in a waveform editor, pick any
audio clip and give it an ampli-
fication of 10 dB or more. Now, in your waveform editor, zoom into
the top of the wave and scroll through the wave. You will see at
many places where the wave “flattens out” at the peak and stays
that way for a while before coming back down. This is called
Clipping—the waveform is “clipped” at the maximum capacity of
your soundcard’s amplifier.

Every audio editing tool will have at least one way to warn you
before you end up with a clipped waveform. Audacity won’t even
let you apply amplification if it sees that the audio is going to be
clipped (unless, of course, you explicitly tell it to allow clipping. A
checkbox called Allow Clipping will let you amplify such that the
loudest sound will be over the allowed threshold—which means it
will probably distort at that point.). Audition, on the other hand,
will show you red warning signs in the Levels frame at the bottom. 

Of course, adjusting amplifica-
tion is something you’ll need to
control yourself, so it’s going to be
quite inconvenient when you have
a hundred or so audio files (and
don’t we all!) that need tweaking.
For amplification that’s a no-brain-
er and can safely be run in a batch,
you need to normalise the audio. You shall not clip! Audacity stops

you from mistakes you might regret

Audition warns you a little later
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Recording

Afew of us play musical instruments, and it’s obvious that we’d
want to record our creations to our PCs in order to be able to mix

and share them with friends. Apart from this, there are many
instances where we have audio recorded on separate media or
gadgets, and want to transfer it to our PCs. That’s where recording
comes in.
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6.1 Getting Set To Record

There are a few things you need to have in order to be able to
record sound to your hard drive. For starters, you need to have a
sound card with microphone and line-in input jacks. If you’re
looking to record voice, you will need a microphone, or else, if
you’re looking to record from another audio source, you will
need to have another player that can play back as a source for
the audio.

Remember the days of the audio cassette? So many of us 
have such rare and cherished collections on audio cassettes, 
but don’t have cassette decks (or players) anymore! Some of 
the albums we have aren’t even available anymore, on CD or on
the Net. So what can you do? Simple: just clean up your old cas-
sette deck, connect its output to the line-in of the computer, and
start recording!

We’ll walk you through that a little later, but for now, you’ve
already found one good reason to learn how to record to
your computer.

Another very good reason, especially for journalists, is when
you interview someone and use a mini cassette voice recorder.
Often, the volume of the recorded voice is too soft, and there’s too
much noise in the background. The simplest thing to do would be
to record it to the PC and then use an editor such as Audacity to
clean it up and make it louder.

Then of course there’s the case of wanting to record your voice
or musical instrument to the PC…

6.1.1 Setting Up
If you just bought yourself a sound card and are looking to record
from any type of audio source, you need to first set up your com-
puter for sound. If you haven’t read through the previous chapter
on how to set up the audio editing PC, you should do so now.
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Once you have your sound
card, microphone and speak-
ers in place, you will need to
set them up for recording. If
you’re using the microphone,
there’s nothing more you
need to do in terms of setting
up. If you want to record from
a cassette player or from a
musical instrument, however,
you will need to connect the
audio output of the source to
the line-in of the PC.

Next, see if you have the
little speaker icon in the
taskbar and double-click it. If
not, you will have to go to Control Panel > Sound and Audio
Devices, and then check “Place volume icon in the taskbar”. Click
Apply and then OK, and you will see the speaker icon. If the
option is greyed out, you will
need to make sure your
sound card drivers are
installed, and that there are
no devices with yellow excla-
mation marks (meaning
wrongly configured hard-
ware) in the Device Manager.

Once you double-click on
the speaker icon, you will see
the volume controls pop up.
Now, click on Options >
Properties, and select the
Recording radio button.
Under the “Show the follow-
ing volume controls” head-

Check the appropriate box to display the
Volume Control icon in the Taskbar

You can choose what settings you want to
see in the Recording Control box
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ing, you will see various
options for inputs; make sure
Aux, Microphone and Line In
are checked. Click OK, and
you will see the options you
selected displayed in the
Recording Control dialog.

If you’re going to be using
the Microphone to record
your sound, check the Select
box below Microphone. Repeat the same procedure for when you
have to record using the line-in port on the sound card. Since you
can only select one input at a time, you will have to repeat this pro-
cedure once you’re finished using, say, the Microphone and now
want to record using the line-in input.

6.1.2 Keep It Quiet
When recording using the microphone, you will have to make sure
to cut down on ambient noise. Some microphones are extremely
sensitive, and might even pick up the whirring of the CPU fan. You
should even switch off ceiling fans, and make sure all windows
and doors are closed. 

If you can, block the gaps between the floor and the door(s)
with cloth to keep ambient sound to a minimum. Also block off
gaps in windows.

Next, you should be concerned about the placement of the
microphone. In order to reduce or avoid any echo or reflected
sounds, make sure that the immediate surroundings have irregu-
lar surfaces (basically anything but blank walls). A soft rug hang-
ing on the wall, or a bookshelf, or even sticking the egg trays on
the wall are good deterrents to echoes. The simple physics is that
irregular surfaces do not reflect sound well, and thus prevent you
from getting a dull-sounding recording. Also, try not to face a
wall at a 90 degree angle—a 60 to 45 degree angle will send any

Check the box corresponding to the input
you want to record from
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reflected sound off in a different direction rather than straight
back at you.

The next thing to do is try and use headphones instead of
speakers. This is because, with the default settings, anything you
input into the PC is output through the speakers. So if you speak
into a microphone, unless you specifically mute its output, your
voice will be played back through your speakers. This can cause
feedback or weird echoes, and you certainly want none of that!

If you just have to use speakers, make sure you mute the micro-
phone output. You can do this by double-clicking the speaker icon
on the task bar and muting the microphone. Don’t worry—this will
not cause your microphone to stop picking up sound; it will just
prevent the sounds picked up from being instantly played back
through your speakers. If you have to hear what you’re saying, for
reassurance, pull down the microphone volume to an extent where
you can just about hear its output from your speakers. Also, make
sure your speakers are
pointed away from
the microphone. 

Do a test record,
for which you can use
Microsoft’s own
Sound Recorder. Go to
Start > Programs >
Accessories >
Entertainment >
Sound Recorder. You
will see the Sound
Recorder window.
Click on the big red
record button to start
recording. If you’re
going to be speaking
into the microphone,

You can use the “sndvol32 -record” command to
get directly to Recording Control
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do so normally. Then play back
the sound to make sure it isn’t
too loud or too soft. If it is either
too loud or too soft, you will
have to go to the Recording
Control—Start > Run, type in
“sndvol32 -record” and press
[Enter]. Here, increase or
decrease the volume of the
microphone as required.

Once you’ve set a satisfacto-
ry volume, you should be able to
hear your voice clearly without
any distortion or jarring. This
means that your microphone is
set optimally. If you don’t change any volume control settings, this
should be a permanent tweak. You’re now set to record using the
microphone. In order to record from the line-in input on your
card, you will have to do all the same tasks you did to set up your
microphone (except for sound-proofing your room).

6.1.3 Recording Using Audacity
Start up Audacity, and the first thing you should do is head to Edit
> Preferences, or press [Ctrl] + [P], and under the Audio I/O tab, make
sure your sound card is selected
as the source for both Playback
and Recording. Also make sure
that the number of channels is
set to “2 (Stereo)”, or else every-
thing will record in mono!

Now make sure you’ve con-
nected the device you are
recording from to the correct
input jack (microphone or line-
in), and also that the same is

You can use the “sndvol32 -record”
command to get directly to Recording
Control

First set Audacity to record in stereo
from the Preferences
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being used as the recording
source in the Recording Control
options (Start > Run > “sndvol32
-record” > [Enter]). Once you’re
set, do a test run to see what vol-
ume levels are acceptable for recording without any clipping. You
will be able to tell by looking at the waveform that’s being record-
ed: if it goes above or below the threshold, it’s clipping! This will
cause distortion during playback, so lower the input volume. If the
input volume is already all the way down, and clipping is still
occurring, try lowering the volume of the input itself from the
Volume Control options.

If you want to record everything that is played through your
sound card, go back to the Recording Control options and set the
input source as Stereo Mix. Now, go back to Audacity and try
recording again. If there is no clipping occurring, you’re set to
start recording.

Always start recording before you begin playing back the track
from the source—it’s a lot easier to delete blank spaces in wave-
forms than to start over and record from scratch because you
missed the beginning of the song!

To start recording, just press the big red record button, which
is the universal symbol for recording. Now, quickly start the source
audio that you want to record and wait for the song to finish play-
ing. Since the volume settings are saved for all recordings after-
wards, it’s a good idea to keep an eye out for clipping to prevent
distorted playback!

Once you’re done recording, you can choose to just save 
the file, or normalise it first. We suggest you normalise the file
and then save it (see §5.5.1 for more on normalising). When you
try and save the file as an MP3, you will get a dialog box from
Audacity asking you to specify where the LAME encoder DLL 
file is saved.

Here’s what you see the first time you
try and save a file as an MP3
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Point it to the right location
and then save the file as an
MP3. You will also be asked to
provide ID3 tag information
for the MP3 you are creating.
You should do so.

Of course, you can try and
edit the files before saving
them, and apply effects to them
such as Bass Boost for songs
with weak bass lines, but that’s not common practice! Whether
it’s guitars, vocals, recording from streaming video or just simply
converting your audio cassettes into the MP3 format, the proce-
dure for recording and saving remains the same.
Congratulations—you’ve now learnt how to go about digitising
your collection!

Just add the ID3v2 information and
press OK to save as MP3
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Effects

There’s plenty you can do to make your audio sound better—from
simple volume boosts to some very weird effects. Here’s the skinny

on how you can clean up your audio or turn it into something entirely
new. We’ll be using both Adobe Audition (a 30-day trial of which you
will find on the April 2006 Digit DVD), and Audacity (which you will
find on this month’s CD). If you haven’t done so already, refer §5.5.1
and §5.6 for the basic effects—normalising and amplifying.
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7.1 Noise Filters 

The biggest inconvenience you are going to encounter in the world
of digital audio is with recordings you made using a microphone,
and recordings from old tapes and records. You can’t help it—each
of these files will have an annoying hiss in the background that
can range from mildly disturbing to extremely annoying. 

The problem
here is Noise—elec-
trical disturbances
that inevitably get
into your music
through wires or
poor contacts. Noise
is prevalent across
the entire frequen-
cy spectrum of your
sound, so it’s very
difficult to remove.
Thankfully, not
only do all worthy
audio editors come with their own noise removal tools, you also
have dedicated audio cleaning software like MAGIX Audio
Cleaning Lab to help you through these painful times.

7.1.1 How to use a Noise Filter
The first thing you need to do to remove noise from your audio
is to build a noise profile. A noise profile indicates how strong the
noise is at different frequencies throughout the audio clip. To
build a noise profile, you need to select a portion of your audio
that is supposed to be silent, but actually has a very audible
hiss—the first couple of seconds before the music begins are
ideal for this.

Once you’ve selected an area that provides a sample of 
the noise, fire up the noise remover—you’ll find it in the 

MAGIX Audio Cleaning Lab makes noise removal
a snap
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Effects menu of your
program (Adobe
Audition categorises it
under Restoration).
Choose the “Build
Noise Profile” option
from there.

Now that you’ve
built a noise profile,
the program knows
what it should look out
for. Select the entire
waveform and apply
the noise removal
tool—your music should now be noise-free.

While Audacity does the basic job of noise removal quite
admirably, you’re going to need more advanced audio editors to
salvage really bad audio. Adobe Audition has its own tools for
removing Hisses, Clicks and Pops. Dedicated audio cleaners such
as MAGIX Audio Cleaning Lab offer even more advanced methods
like the Spectral Cleaner, which lets you edit out background
sounds such as coughs and slamming doors.

7.2 Just For Fun

Well, we’ve cleaned up bad audio, but what does one do with clean
audio? Why, mess it up, of course! Whether you want your songs
to sound like they’re coming from under water or playing in a
large stadium, it can all be easily arranged.

7.2.1 Time and Pitch effects
For an explanation of Tempo and Pitch, refer §5.2. There are three
ways you can use these effects:

Building a Noise Profile in Adobe Audition
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1. Time-Only: You can make the
music run faster or slower, keep-
ing the pitch intact. Unlike fast-
forwarding a tape, where peo-
ple’s voices get squeakier the
faster the tape moves, this will
sound more like faster or slower
singing. 

2. Pitch-Only: The converse of
time-only effects, you can
change the pitch of the music
without changing the length of
the track. For example, by
increasing the pitch, you could
make even James Earl Jones
sound like a chipmunk!

3. Both: This is your standard
my-audio-tape-is-running-too-fast effect. Not only will the audio

Time-Only effects change only time—the
frequency spectrum remains the same

Pitch-Only effects change only
frequencies—the time remains the

same
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clip run faster, the sound will also come out a lot higher than
it should.

Adobe Audition throws in all time and pitch effects under
Effects > Time/Pitch, while Audacity has them under Effects as
Change Pitch, Change Speed (both time and pitch will be affected),
and Change Tempo (only time will be affected).

7.2.2 Reverbs
Reverberation effects—or simply “reverbs”—can be used to simu-
late the natural effect of sound bouncing off surfaces and creating
echoes. These echoes occur so quickly that the human ear barely
make out the difference between the original sound and the echo.
Still, the effect is strong enough to for us to be able to identify the
environment, be it a tiled bathroom or a cramped closet.

So even if you’ve got the studio version of a song, you could use
the reverb effect to give it a “concert hall” sound and brag to your
friends about how you have a rare live version.

Both time and frequency
are altered in this type of effect



VII EFFECTS

100

DIGITAL AUDIO

FAST TRACK

Your audio editor will give you a lot of
flexibility when it comes to simulating
these real-life effects—you can enter the
size of the room, the damping (how much
strength the sound loses when it bounces
off a surface), and many other parame-
ters. Audition’s Full Reverb effect offers
you enough options to make you dizzy,
and the sound quality is quite impressive
as well.

7.2.3 Flanges and Wahwahs
In audio lingo, flanging is mixing
identical audio signals, albeit with
one slightly delayed. The delay is
usually not fixed, and varies over a
small range. The resulting sound is
a strange, psychedelic effect remi-
niscent of the weird, “trippy”
music of the ’60s and ’70s. This is
much like listening to music
through a long drainpipe.

The funny-sounding wahwah
effect gets its name from the gui-
tar special-effect pedal by the same name. The wahwah effect gives
music a very expressive, pulsing feel—much like saying “wah” or
the siren of an ambulance. 

Adobe Audition’s Full
Reverb effect

Audition’s Flanger

An innocent guitar riff… and then… Wahwah!
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7.3 Getting More Effects

We don’t live in the dark ages of audio editing any more—you
don’t need a million editing programs just so you can have the
widest choices of effects. For a much wider choice of effects, you
can extend nearly any audio editor thanks to a standard plugin
architecture called VST—Virtual Studio Technology.

7.3.1 What are VST Plugins?
Virtual Studio Technology (VST) is a standard interface by which
effects can be loaded into any audio editing program. The archi-
tecture was developed by German company Steinberg, and has
found immense popularity. At a conservative estimate, at least
1,500 VST effects exist, most of them free of cost.

The purpose of the VST effect is to replace as much of the
recording studio’s hardware as possible to create a Virtual Studio.
In the second version of the VST architecture, Steinberg intro-
duced the ability to send MIDI data to the audio editing program,
thus giving rise to the VST Instrument. As the name suggests, VST
Instruments can simulate MIDI synthesizers to let you create your
own music on-the-fly. Most VST effects work in real-time, so you’ll
need a considerably powerful processor to run them.

7.3.2 Where do I get them?
A simple Google search will take you to a gaggle of Web sites where
you can get free VST plugins. Here are a few that caught our attention:

AudiOracle (www.audioracle.com/freetrials.php)
VST Instruments ranging from the extremely useful to the utterly
pointless and fun. You will also find plenty of resources and arti-
cles on audio editing, as well as a forum where you can discuss
audio with other members.

Tweakbench (www.tweakbench.com)
Tweakbench has a collection of weirdly-named VST Effects
and Instruments. Choose from drum kits, tone generators and
many more.
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GERSIC.com (www.gersic.com/plugins/)
A massive database of plugins, effects and instruments, all neatly
categorised and updated regularly.

7.3.3 How do I install them?
Installing a VST plugin is ridiculously easy—they’re available as
DLL files, which you just need to put in a standard folder. Point
your audio editor to use this folder as the default location for VST
plugins, and you’re done! You might need to restart the audio edi-
tor or refresh its effect list every time you add a new effect.

7.3.4 Some cool VST Effects and Instruments

Carillon
Carillon is a bell and chime synthesizer,
and even has a bunch of chorus and
reverb effects. Ready to start creating
your own version of ACDC’s Hell’s Bells?

Stringer
Fancy a string orchestra on your PC? Stringer comes chock-full of
sound samples from string instruments which you can now use in
your own creations.

Bojo Organ One
Organ One is a virtual 16-voice organ. Eerie gothic music is a snap
with this one!

XOXOS Pack
A massive bundle of VST plugins—from the
Synger voice synthesizer to the Murder
distortion effect. There’s plenty here to
keep you occupied.
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The Home DJ

Got turned down by the hot club down the street? Don’t worry,
you’ll be showing them a thing or two about mixing music soon

enough—here’s how to transform your PC into your own music
studio without even getting out of your pyjamas.
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8.1 The Toolbox

We’re assuming that you’ve read §5.1 and made sure that your PC
is up to the task—especially if you’re going to be mixing music in
real-time. The next thing, of course, is software. To choose the
right software, you’ll first need to decide how you’re going to pro-
duce your music. Would you rather mix tracks live for a party at
home (karaoke night, perhaps?), or would you rather create your
mix at your pace? We’ve looked at software in both categories, so
take your pick!

To our considerable disappointment, we’ve discovered that
though there are some good free tools, none of them really holds
a candle to the paid, more advanced versions. No “free vs. paid”
war here—paid wins each time.

VirtualDJ—The Life of the Party
The darling of many
professional DJs
across the world,
VirtualDJ is so easy to
use you probably
wouldn’t believe that
even the pros use it.
It’s got a typical two-
turntable setup—load
your files onto them
and mix away! You
can even scratch
records back and
forth for some cool intro and exit effects. And with its special
“beatlock” engine, your tracks will emerge from a scratch still in
sync. You will also have a number of sound bites and effects which
you can work into your mix. For karaoke night, there’s a special
effect that lets you cut out vocals (though the accuracy of this fea-
ture can’t always be guaranteed) so you can sing along without the
real singer’s voice bothering you. You can record your session as an

VirtualDJ—quite like the real DJ’s set up
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MP3 to show off to friends later, burn it on to your CD, and when
you’re ready, broadcast it over the internet for everyone to hear.
You’re going to need an enviable internet connection for that last
feature, and so will your audience.

Visiosonic PCDJ FX
PCDJ has all the goodies
you’ll need in DJ mixing
software—two decks, the
ability to organise your
music, apply effects and
adjust tempo, just to
name a few. The interface
is a little weird to get
around, but you’ll settle
in eventually. The feature
set is almost identical to
that of VirtualDJ, but how
much PCDJ scores over it
depends on how success-
ful it’s VRM (Virtual Rack Module) plugin system is going to be—its
plugins are made to look just like the machinery that would be put
on large audio racks (in real recording studios) to add effects.

ACID XPress 5.0—The teaser mixer
ACID Music Studio and
ACID Pro are both incredi-
bly powerful tools to cre-
ate your own music,
remix existing music, add
soundtracks to video, and
a plethora of other music
authoring features. They
do cost a bomb, however,
which is why we have
ACID Xpress—a stripped
down version of both,

PCDJ—a little arcane, but still powerful

ACID Xpress—the big tease that nags you to
go pro
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which in itself is quite the powerful tool. It features an easy-to-use
interface, where you can “paint” on the different tracks of your
music, time-stretch it on the fly and create impeccable loops. It even
has a bunch of how-to tutorials when it starts up to show you just
what you can do with it. Sure, it does nag you to buy the paid ver-
sions for the cooler features, but this one still wins some kudos as is.

FL Studio 6.0
Formerly FruityLoops, it’s no
wonder that the word
“Studio” had to be added to
the name—FL Studio has
always been a favourite with
those interested in creating
their own dance music tracks.
While it started out primarily
as a software to create music
loops, it’s now a full-blown
music mixer, complete with
effects processors and other
bells and whistles. You’ll be able to create some semblance of music
within the first minute of your session—that’s how easy it is to use.
All you need to know is that unlike many editors today that let you
place sound clips on a timeline, here you enable or disable them
using on-off switches that determine when a sound is going to be
played. Though still quite heavily geared towards the creation of
new music rather than mixing existing sound, it’s quite an amazing
tool. It even supports the open VST architecture, so you can keep
adding plugins whenever you want. And if all that weren’t enough,
Blake Reary’s Hanging On, recorded exclusively for FL Studio in FL
Studio is one of the most addictive tracks we’ve heard in a while.

Cubase
Steinberg Audio’s (the creators of the VST open architecture) flag-
ship product, Cubase, had been much abused for its CPU-hogging
capabilities, but Steinberg cleaned up their act and Cubase is now
one of the fastest mixing programs out there, even on compara-

FL Studio—still quite fruity
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tively low-end PCs. The sound is impeccable and the mixer, too, is
quite easy to use. The interface is quite similar to other audio
sequencers, so users will have little or no trouble getting used to it.
It also comes with a fairly powerful audio editor, so you don’t need
to switch programs for minor adjustments to audio.

8.2 Recipe For A Remix

With so many remixes on our TV and radio channels today, you’re
probably wondering if you could do a better job at it than some of
the artists seem to. Well, go ahead and try!

The Ingredients
1. Audio Track (1)
Obviously the most essential. You can use anything from your own
private music collection, but if you plan to inflict this remix on
the rest of the population, you will need to find yourself a royalty-
free track lest you get persecuted for copyright infringement. If
you can, get your hands on an a cappella track—one with no musi-
cal instruments, just voice. Or you could just record your own. This
way, you won’t have to bother about cutting out any background
music—just start mixing immediately. 

2. Audio Editor (1)
You’re going to need this for a lot of things, including cleaning up
your main track and the other sound clips you’re going to use. Our
recommendation is Adobe Audition (or its former self, Cool Edit
Pro), though Audacity should also work well. 

3. Audio Mixer (1)
If you’re going to use Adobe Audition as your audio editor, you can
stick with it and use its own impressive multi-track editor. Audacity,
too, is quite capable of mixing music, though this can be a bit tire-
some. If you don’t wish to spend any money at all, Audacity and ACID
Xpress is the combination for you. You might also want to choose a
mixer that lets you create music to be inserted into the mix.
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4. Audio Clips and Loops (To Taste)
Find yourself a few good loops which you can use as the back-
ground for your remix—we’ve thrown in a list later in this chapter.
And what’s a good remix without some weird sound effects and
random voices? Get some of those, too.

5. Time (Plenty, To Taste)
Remixing audio is a task that requires the patience of a hermit—
you’re not going to get the results you want in a jiffy, so if you
expect to churn out a winner in five minutes, you’re going to be
sorely disappointed.

The Procedure
1. Prepare the track
If you’ve decided to pick a track from your own collection, your
first task is to isolate as
much of the voice as pos-
sible. To do this, you will
need your audio editor’s
graphic equaliser. You
will usually find voice
between the 300 Hz and 3
kHz frequencies—use the
equaliser to cut out all
but this frequency range.
Of course, this is going to
change from artist to
artist, so you will need to
experiment with differ-
ent frequency ranges.

We tried this in
Audacity, and its slightly
eccentric equaliser, cou-
pled with its lack of a real-
time preview, made things
rather annoying. Audition,

Audacity’s Equaliser—useful, and yet a little
useless

Audition’s Equaliser—full, functional and fun
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on the other hand, has the option of using a 30-band graphic equalis-
er and a real-time preview, so isolating the vocals took a lot less time.
If you’ve managed to lay your hands on an a cappella track or have
recorded your own voice, make sure you’ve cleaned up the track
using the techniques we mentioned in Chapter 5.

2. Cut up the track
For a better remix, it would be wise to cut up the voice track into
smaller “sound bites” rather than keep it as an entire track. This
way it’ll be more manageable, especially if you want to create a
remix that’s much longer than the original. Any audio editor
should be able to do this without flinching.

3. Set the pace
You’re probably going to speed up or slow down the track you’re
remixing, so use your audio editor to change the pace. In mixers
such as ACID Xpress, you can speed up or slow down the entire
mix, which is going to help you synchro-
nise the voice and drum loops better.

4. Start Mixing!
Now that you’ve finished with the pre-
liminaries, you can start adding sound
clips to your multi-track audio mixer.
Most of them will let you just drag and
drop music clips onto different tracks.
You can manipulate the sound in each
track independently, and the final result
will be an addition, or a mix of
everything in the mixer. You will

Mixing in Audition

Mixing in Audacity

Mixing in ACID Xpress
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also be able to set the volume for each sound clip. A drum loop in
the background, a few screeches and squeals generously spread
out, and your remix is done! 

5. Render your mix
Once you’ve finished concocting your mix, you can export it to
nearly any popular audio format—MP3, OGG, WMA, and so on.

6. Take your talents online!
Getting pretty good, eh? Curious to know how you match up against
other wannabes across the planet? The ACID Web site, www.acid-
planet.com, regularly holds remix contests featuring even big artists
such as Madonna and Depeche Mode. They’ll provide you with a cap-
pella tracks that you must remix, and their crack team of judges
will do what they’re supposed to—judge. If your remix is the best,
it’ll get featured on the artist’s next album. By the time this issue
gets to you, only 20 days will be left for the current contest, so rush
in your entry or start practicing for the next one.

8.3 Getting A Bite Of Sound

So you want to make a remix but don’t know where to turn for a
good loop? Be very careful about what you use in your mixes—using
a loop without checking its copyright agreement could result you
breaking the law without even realising it till someone sends you a
hate-mail calling you a pirate. So there’s a tip—always read the copy-
right agreement, even if it’s a guaranteed free MP3.

Here’s a list of sites that offer royalty-free loop and other ran-
dom sound effect downloads:

Proloops Freeloops section
http://www.proloops.com/freeloops.asp
Though the site’s primary function is to let you buy royalty-free
loops for your own use, it also has a free section that features
around 50 to a hundred free loops every month. The loops will
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range from genres like garage and
country to weird ones like pot and pan
sounds. The free section is definitely
quite the teaser: if that’s anything to
go by, the paid section is probably
monumental!

Partners in Rhyme
www.partnersinrhyme.com
A cornucopia of royalty-free music
(most of it paid, though), Partners in
Rhyme does offer a large number of
free sound effects, neatly categorised
into categories like ambient, vehicles,
animals, human and so on. You will
also find free MIDI files, a few free
drum loops, and links to sites where
you can find free MP3 music.

ACID Planet
www.acidplanet.com
Home of ACID software, ACID planet has
a huge collection of free drum and music
loops for your track. You will also get a
bunch of bonus loops when you decide to
enter their online contest. 

The Free Sound Effects Index
http://www.stonewashed.net/sfx.html
As the name suggests, the site offers
links to free sound effects on the
Internet. Some of them are too good to
be true, naturally, but you’ll actually
find yourself led to a respectable num-
ber of sites that are quite real and do
provide some neat loops.
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EchoVibes
http://www.echovibes.com/
Dedicated to helping Web
designers bring life to their
Web content (as they claim),
EchoVibes has a bundle of cool sound effects, all categorised.
The site’s interface is a little difficult to navigate—the images
make no sense if you’re running on a high resolution.

Sounddogs
www.sounddogs.com
The name itself inspires you to belt out
numbers (“you ain’t nothing but a
sound dog..”) from eras you forgot exist-
ed. You can choose from sound effects
to vocals to loops, even telephone ring-
tones. You can also get them in bulk
“doggy packs”—themed collections of
sounds, though these need to be paid for, unfortunately.

Flashkit
www.flashkit.com
You’re going to find a lot of free loops
here, but not without some effort—you’ll
find them hiding among loops that are
copyright protected, so as long as you
keep an eye out, you won’t end up breach-
ing any copyright laws.

Psy-Lab
www.psy-lab.com
Though it looks suspiciously like an
advertising site (it is, for the most
part anyway), some patient trawling
will actually lead you to some useful
sites with free downloadable music
and sound effects.



Computer Music Tutorials
http://www.computermusictutorials.com
Apart from tutorials (as suggested so
overtly by the title), you will also find
a monthly sound effect pack. For
freebie junkies, there are links to
free audio editors and recorders as
well. You will also find free VST plu-
gins to use with your current editor!
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MIDI

It’s been around since we were wee children. First, as a way for
musical instruments to talk to computers, then as game

music, and now as ringtones on our cellular phones. Here’s to
the never-say-die technology that is MIDI—the Musical
Instrument Digital Interface.
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9.1 Introduction

Developed in the late seventies and early eighties, MIDI isn’t real-
ly an audio format—rather, it’s a protocol that defines musical
notes in a precise format that computers can understand. This lets
musical instruments (especially synthesizers) and computers talk
to each other easily. When a musical instrument is connected to a
PC via a MIDI interface (an interface that conforms to the MIDI pro-
tocol—this could be a serial port or a USB connector), it sends it:

1. A number indicating which note was pressed
2.When the note was pressed and subsequently released, and
3.How hard it was pressed

MIDI Sequencers are programs that
record the above data and can now
play it back at any speed and with
any effect you wish to apply. The data
is sent to your PC’s MIDI synthesizer
(which combines all the MIDI infor-
mation to finally generate a sound).
You can see the MIDI synthesizer by
right-clicking on the volume icon on
the taskbar, choosing “Adjust Audio
Properties” and selecting the
“Audio” tab.

Wavetable Synthesis
In ye olde darke ages of computing, MIDI music was made up of
single, boring tones, much like the ancient black-and-white cell
phones. As MIDI grew, the need to emulate different instruments
like pianos, guitars and violins became greater, and synthesizers  

The great thing about MIDI is its sheer compactness—a 10 KB
file can easily hold a minute of MIDI audio, making MIDI
sequences the ideal choice for game music and any other applica-
tion that requires a lot of audio in very little space.

Viewing your default MIDI
synthesizer. For Windows XP
users, it’s the Microsoft GS
Wavetable SW Synth
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Of course, MIDI wouldn’t be fun if you needed a real live musi-
cal instrument to create your music, now, would it? You don’t
need to tinker around with hardware every time—you can choose
from a wide range of software to begin creating and editing MIDI
sequences, or you can use VST instruments (which we talked about
in chapter 8) with your preferred audio editing program.

9.2 Software 

Nearly all MIDI creation software offer you a virtual music key-
board of your own. All you need to do to use these are load up a
sample instrument and play away! Here are some essential pro-
grams to get you started with creating your own MIDI sequences.

FL Studio
This incredibly powerful mixer
is also quite capable of creating
some really awesome MIDI
tracks. And unlike other pro-
grams that let you play only one
note at a time, FL Studio’s
unique and user-friendly Piano
Roll lets you easily create chords
and other effects such as gliding
over the keys of the keyboard. It
also comes loaded with a bunch of VST instruments, offering a
mind-boggling variety of instrument samples. After you’ve used it
for a while, the $99 (Rs 4,300) price tag appears surprisingly small.

Cakewalk Sonar 5
Cakewalk, too, has been a leader 
in the world of music creation.
Sonar 5 is practically a whole record-
ing studio inside your humble 
PC—from sequencing MIDI to pro-
cessing effects. 

FL Studio—the incredible MIDI maker

Cakewalk’s incredible Sonar
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Anvil Studio
Anvil Studio lets you create a
multi-track MIDI file with
incredible ease. It also offers you
a large number of instrument
samples, so you’re literally spoilt
for choice. Its most noteworthy
feature, however, is the tutorial
interface—the bottom half of the
screen always contains very helpful tips and instructions on how
to use Anvil, so you’ll never be lost. And best of all, it’s free!

9.3 Creating Your Own MIDI Track In
Anvil Studio

Let’s use this free MIDI editor to create our own little song. To 
get an idea of the different areas of Anvil Studio, take a look at 
the screenshot.

Anvil Studio—free!

The Mixer

Help

Compose
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The Lead Track
This will the song’s main
melody, so let’s rename it in the
mixer by clicking on the track
name and calling it Main.

By default, the track type is
Instrument—leave it that way.
Click under Instrument to bring
up a list of instruments you can
choose from, and select the
instrument. To start playing the
song, click on the Compose button.

Composing the Lead Track
The Composer, by default, is a piano keyboard which you can play
by either using the
mouse to click on the
keys or by using your PC’s
keyboard. You will also
find a bar with musical
notation, which will
make little or no sense if you haven’t formally studied music.
Thankfully, Anvil Studio’s really handy help panel contains
instructions to help you out.

If you find the piano keyboard uncomfortable to work with, you
can select “Piano Roll” from the drop-down menu at the top left.

Creating the melody is going to involve a lot of experimenta-
tion, and can end up as a long and frustrating exercise, but it will
be worth it when you finally have your own composition ready!

Drums and Rhythms
Now that you’ve created a melody, it’s time to add a rhythm track
for the background. Go to Track > Create > Rhythm Track to create
a new track.

The Composer

Choosing the track type and
instrument
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In the Compose screen, click
on the Add Sounds button to get
a list of drums. The most com-
mon are the Bass and Snare
drums, so you can start with
those. You will now see the
drums in a multi-track display. Clicking anywhere on these tracks
will play the drum at that position.

Audio Tracks
If you’ve got sounds (in
the WAV format) on
your hard disk that you
want to introduce into
your song, you should
create an Audio track.
Go to Track > Create >
Audio Track by
Importing a .wav file for this. For audio tracks, Anvil gives you the
option to add sound effects, should you choose to. Click on “fx” to
the right of the track to bring up a list of effects you can apply. Anvil,
too, supports the VST plugin architecture, so you can keep adding
new effects on a whim. 

Mixing them up
To the right of every track, you will find sliders for Volume and
Pan. The Pan slider lets you decide how the track is balanced
between your two speakers—dragging it to the right will bias it
towards the right speaker, and if you drag it to the left, it will be
biased towards the left speaker.

Now that you’re done with the basic tracks, you can add more
instrument tracks for some more background music. For example,
you could create another instrument track and choose bass guitar
to create some low mumbles in the background. And if you ever
get stuck, Anvil’s help is right there, so tinker away!

Loading an audio track

The drum tracks
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9.4 MIDI Music Online

Easy that they are to make, there’s no dearth of MIDI files online—
all of them even categorised under various genres of music, artists,
alphabetically—it’s a mad MIDI world out there. If you’ve ever had
a favourite song, the probability of finding a MIDI version of it is
tremendous—whether it’s classic rock (you haven’t truly heard Pink
Floyd’s Comfortably Numb till you’ve heard it in MIDI), techno, disco
or even pseudo-grunge-garage-pop (we made that last one up).
Here’s a list of sites you can visit for free MIDI audio.

The MIDI Database
www.mididb.com
Quite suggestive by name itself, the MIDI Database is a, well, data-
base of a wide variety of MIDI files. The front page features the top
five MIDI downloads for each genre. The music is a little contem-
porary and features mostly songs you’d be familiar with. It also has
a section on Copyright FAQs, which you must refer to if you intend
to use these MIDI files for anything other than personal use.

www.midicenter.com
Another MIDI Database, the MIDI Center has a huge database of
songs ranging from the run-of-the-mill to weird and unheard-of
music. You will find lists of the newest songs, the most popular
and the top rated for your perusal.

www.FindMIDIs.com
FindMIDIs features an alphabetically-organised list of MIDI files.
One thing we liked about the site was its “Play Random MIDI” but-
ton, which was quite educational—it seems there is a lot of terrible
music out there just waiting to pounce on you.

www.musicrobot.com
A handy MIDI search engine, Musicrobot lets you search for songs
either by song name or band name.



Section III
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Cataloguing Software

Joy and pain; two emotions very commonly felt by everyone who has
a music collection spanning eras, genres and gigabytes. Of course it

is pride that you feel when you gaze fondly at the rare Beatles mixtapes
that you acquired digital versions of. However, it is also agony that
accompanies your satisfaction as you browse through your collection
and notice that, like The Beatles, it’s going to be a Hard Day’s Night if
you decide to find anything amongst the various files, formats and
folders on the hard drive...
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Given that your music is stored in various compression formats
(MP3, AAC, WMA, OGG, etc.) on various locations on your hard

drive it becomes almost a necessity to have some sort of
‘arrangement’ to your music files. Whether you’re ripping music
off CDs or downloading it off the Internet, unless you’re an uber-
geek, it’s unlikely that you’re keeping it sorted by
artist/album/track number. So how exactly do you keep Madonna in
one place, Kylie in another, and still manage to find them on your
computer instantly? Read on…

10.1 Playlists: The Traditional Way

As the name suggests, a Playlist is a list of songs that are arranged
in an order to be played. And essentially, that’s about as far as a
Playlist will go in arranging your music. At the time when media
players were being introduced on personal computers, Playlists
became an efficient way to keep one’s music organised. The most
popular formats of Playlists (.m3u and .pls) are basically lists of
locations of various media files on your computer. So when you
load a Playlist you are giving your media player an address book of
your media files.

The advantage of maintaining music on Playlists is that you
can make them specific to artist, mood, genre, year, or whatever
grouping you want. Playlists can also be made so that your music
files play in a particular order that you decide.

10.1.1 Making a Playlist
Playlists can be made using practically any media player. For the pur-
pose of demonstration, we have used Windows Media Player (WMP).

1. Drop all the music files you want in the Playlist into the ‘Now 
Playing List’ at the right of the ‘Now Playing’ screen of WMP.
2. Order them in the arrangement of your choice by keeping the 
left mouse button pressed on the song you want and dragging it
up or down the list.
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3. Once done with the 
arrangement, click
File > Save Now
Playing List As
4. Select the location 
where you want to
save the Playlist. Then,
click on the ‘Save as
type’ drop down and
select the ‘M3U
Playlist’ option.
5. Type in whatever
you want the Playlist
to be called and save.

The problem with Playlists is that every time you want to add or
remove a song onto a particular Playlist, you have to do it manually;
adding the files individually or in groups, and then saving the
Playlist again. Also, searching for the right song within multiple
Playlists is a pain. Enter—the next generation of music cataloguing…

10.2 Media Libraries

Like a physical library, a Media Library is a well ordered, easily
searchable store of media files that is also terribly quiet. It is a fea-
ture of most of today’s popular media players and is an efficient
way of organizing and accessing your music on your computer.
What a Media Library essentially does is access information from
all the media files on your hard drive and displays the same con-
veniently making searching for files very, very easy.

A Media Library lists all the songs on your hard drive(s) in a
menu that allows you to see all the pertinent information about
the files, i.e. song name, artist, album, time, etc. It serves the pur-
pose of a Playlist too as it can sort your files in exactly the way and
order you want them.

It makes sense to store all your Playlists in the
same location
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10.2.1 Sort = Search
The best part about Media
Libraries is the automatic
sorting that the software per-
forms, i.e. as soon as you add
files to your library your
music is sorted by Artist,
Album, Genre, Year, etc. This
means that when you search,
you can search for all songs of
a particular artist, album,
genre, year, etc. In fact, most
available media players also allow you to sync your Portable
Devices with your Media Library so transferring your favourite
songs to your Portable Device becomes a sync… er… synch.

10.2.2 Ratings Are Everything
No, we’re not being TV show producers here. Media players allow
you to give ratings, usually on a 5 star scale, to individual songs
or a group of songs you are listening to. This means that you can
give the boy band songs in your library (shame on you!) a one star
rating, and a five star rating to all your Alanis Morissette stuff!
Media Libraries allow you to sort music according to your ratings
as well, so you can access all your top rated songs at any given
time. You can also change the ratings any time, and any number
of times, you like. 

10.2.3 Dynamic Playlists
A Dynamic Playlist, sometimes called Smart Playlist, is a cus-
tomisable Playlist that allows you to access music on the basis of
certain pre-decided parameters (you decide, of course!). The reason
the nomenclature of this functionality includes the word
‘Dynamic’ is because as and when more files that satisfy your
parameters are added to your library, they get automatically
added to your Playlist as well. You can also Edit (simply right-click
on the Playlist and select ‘Edit Playlist’) the parameters of your
Playlist at any time.

The iTunes’ search function is extremely
user friendly
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10.2.3.1 Making a Dynamic Playlist
Dynamic Playlists make
accessing favourites very easy.
Creating a Dynamic Playlist is
even easier. For the purpose
of demonstration, we have
used the iTunes Media
Library feature.

1. Click File > New Smart
Playlist or use the keyboard
shortcut [Ctrl] + [Alt] + [N].

2.In the menu that pops
up select the parameter(s),
called ‘rules’, that you want
your Playlist to match. For
example, select Artist-is-
<name of artist>

3.You can add Rules to fur-
ther modify your Playlist by
clicking the ‘[+]’ button

4.You can also specify 
the number of songs/min-
utes/hours/ megabytes/
gigabytes you want the
Playlist to contain

5.Select the ‘Live Updating’ option which will add a new file to
the Playlist if it matches all the rule

6.Hit ‘OK’ and voila! 

Winamp (version 5.0 and above) also allows you to make a
Dynamic Playlist. It is called ‘Smart View’ and can be created by
hitting the ‘Library’ button in the Media Library and clicking ‘New
Smart View’. Just title your Smart View aptly, select your parame-
ter(s) and hit ‘OK’.

You can select which parameter(s) you
want to create your Smart Playlist on
the basis of

Winamp’s Smart Views also allow
multiple parameter selection
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10.3 Cataloguing Tools
Okay. So now you know what to do and how to do it, but where the
heck do you do it?!  There are several readily (and more impor-
tantly, freely) available softwares that help one organise one’s
music collection. Here’s a look at some of the most popular ones.

10.3.1 iTunes
iTunes is the proprietary media player of Apple Computers, and is
fast gaining ground as the most popular media application in the
world. Given the dominance of the iPod in the portable audio device
market, it’s not surprising that Apple also have one of the best
media players. Incidentally, iTunes also acts as the sync between the
iPod and your computer.

10.3.1.1 You’ve Come A Long Way Baby
Macintosh software distributed a popular MP3 application called
SoundJam MP which was used by most Mac users. When Apple
bought the rights to SoundJam, it changed the name of the soft-
ware to iTunes, made a few modifications and released it in
January, 2001. Currently, Apple has released version 6.04 of the
software which has several improvements over its predecessors
including access to iTunes store in the user interface itself.

10.3.1.2 Compatibility
Originally, iTunes was designed only for the Mac OS but these days
it is compatible with computers running Windows XP, 2000 and
Server 2003. It is not supported on non-NT versions of Windows
like 98 and Me. Linux users can run iTunes using the Crossover
Office platform. iTunes can be downloaded for free from
www.apple.com/itunes

10.3.1.3 Features, Features Everywhere
With more explorable features than a French supermodel, iTunes
is as user-friendly as it can get. The latest release of the software is
brimming with cool tools that let you organise, access and edit
your media files with German efficiency, Japanese speed and
American spunk. 
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Apart from the regular media player functions (Playlists, Media
Library, ripping music, burning to CD/DVD, etc.) iTunes also has
several nifty features that make it an absolute pleasure to use.

Syncing
The software syncs seamlessly with the iPod and other portable
devices. The Windows version of iTunes, however, can only sync
with the iPod. One can transfer selected Playlists to the iPod, and
once connected, the software will automatically make the neces-
sary additions/removals to the device. 

Podcasting
iTunes allows users to search and download a variety of podcasts
onto one’s computer. You can also configure the software to check
for new podcasts and delete old ones periodically. These options
are available by clicking Edit > Preferences. The latest release of
iTunes also has support for video podcasts and RSS. Users simply
need to enter the feed URL in the pop up menu that arises when
one clicks Advanced > Subscribe to Podcast. One can also access
streaming audio and video by entering the URL in the Advanced >
Open Stream menu.

Party Shuffle
This is a nifty tool meant
essentially as a quick
Playlist creating DJ aid. The
Party Shuffle Playlist ran-
domly selects tracks from
the Media Library, or other
Playlists. One can also edit
the tracks in this Playlist by
simply dragging and drop-
ping files into it. 

10.3.2 Musicmatch Jukebox
Media player using veterans will recall fondly the times when the
most effective CD ripping software was Musicmatch. Before iTunes

Edit the Party Shuffle Playlist on the fly
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was introduced for Windows, Musicmatch Jukebox (MJ) was the
software provided with iPods to sync with Windows PCs. In
October 2004, Yahoo! acquired Musicmatch. A lot of the function-
alities seen in iTunes have clearly been ‘inspired’ from MJ. Like
iTunes (how ironic!) MJ also has an online music store, support for
Internet radio and portable devices, and a pretty efficient Media
Library. With a smartly efficient user interface and clever tools to
boot, MJ is an very good media player option.

AutoDJ
This is effectively the Smart Playlist option of other media play-
ers. The primary difference between the AutoDJ and other Smart
Playlists is that Musicmatch
automatically adds related
artists to the mix you have
built using the
‘Musicmatch Music
Discovery Engine’ which
scans the Internet for infor-
mation on related artists.

10.3.3 Winamp
Winamp has been around
for donkey’s years now and
terms like ‘Playlist’ and ‘Alicia Silverstone skin’ have become pop-
ular mainly because of Winamp’s acceptance as the media player
of choice amongst the masses. Winamp is the Nokia phone of
media players—people who use it, usually don’t want to shift to
other players. Its controls and options are as idiot-proof as can be.
Currently, Nullsoft has released version 5.21 of the software,
which has, among other things, support for almost all portable
devices and support for a variety of streaming content. 

10.3.4 AmaroK
Linux users! Worry not! AmaroK is an audio player built for KDE.
The software is the popular alternative to applications such as JuK
and WMMS. Though it doesn’t come bundled with KDE, this will

AutoDJ is Musicmatch’s answer to Smart
Playlists
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probably change soon. The latest version of AmaroK (version
1.3.9) has several features that are cool enough to make you want
to shift over to Linux, just to use them. For example, using the
ID3 tag (for more on ID3 tags, see chapter 11) of a particular file,
it can download the full lyrics of the song, along with cover art
and even information from Wikipedia about the artist! AmaroK
also has a Playlist browser that allows users to scan various
Playlists on their computers. 
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I
magine living in a world where nobody has a name. So if you’re
standing at a street and you see someone on the other side that
you recognise, you say “Hey, You!” And just as the words leave

your mouth, all the people on the street turn, and look at you... 

Organising Your
Collection
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Nomenclature, for absolutely everything, is imperative. Imagine
if local buses weren’t numbered, or if books weren’t given

titles. Just as going to the destination of your choice, or picking the
right book at a library would be a headache, it is likely that with
thousands of media files on your computer, finding the right one
would be muchos effort if it didn’t have the right file name.

This chapter explains why you really don’t want to listen to
something by Boyzone when you clicked on what you thought was
something by Metallica, and how to completely avoid this situation. 

11.1 ID3 Tags

No, we’re not talking about Tom Cruise’s secret password in Mission
Impossible. Essentially, an ID3 tag allows you to store information
about the MP3 (ID3 is used only in relation to MP3 files) within the
MP3 itself. It’s like the library card of a book, except an ID3 tag
doesn’t leave your MP3 when you “check it out” of your computer. 

Let’s Get Technical
Metadata! That’s what an ID3 tag is. Simply put, Metadata is
information about information. Your standard MP3 file is basically a
collection of zeros and ones, and its identity in defined by a unique
arrangement of those numbers. What an ID3 tag does, as metadata,
is add information about that file, to the file itself. This data is then
accessed by your media player which reads it out as a song name,
artist, album, etc. 

Most media players display song information about MP3s on the
basis of the information stored in ID3 tags. They also allow you to
edit this information and add details such as lyrics, artwork, etc. to
the MP3. But the amount and types of information that you can store
in ID3 tags depends on what version of ID3 you are using. There are
basically two versions of ID3 tags—ID3v1 and ID3v2—but both these
are essentially unrelated.
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11.1.1 ID3v1
Prior to the ‘invention’ (or as they day in software, ‘development’)
of ID3 tags, the only information about the contents of an MP3
file that could be saved on the MP3 file were some simple yes/no
parameters like ‘private’ and ‘copyrighted’.

Then one day in 1996 this guy called Eric Kemp decided that
he really wanted to know which artist he was listening to, and
from which album the song that he was listening to was, and,
basically, other related information about the track as well. So he
developed a program called Studio 3, which added a small
amount (128 bytes) of data to the MP3 file itself. This ‘tag’ was
added to the end of the file so that it did not disturb how the
media player played back the track. A 128 byte ID3 tag has the
following information

❍ Song title: 30 characters (one byte each)
❍ Artist: 30 characters
❍ Album: 30 characters
❍ Comment: 30 characters
❍ Year: 4 characters
❍ Genre: 1 byte

Technically, if you add it all up, it comes up to 125 bytes. The
remaining 3 bytes are ‘TAG’ which is basically, how the media player
identifies an ID3 tag! Initially, some media players played a tiny blip
of static when they read the tag part of the file but all current players
will skip it. Eric Kemp made the byte value of the genre field
correspond with one of 80 pre-defined genres.

11.1.1.1 ID3v1.1
Sometime after the ID3v1 tag was developed, another guy, called
Michael Mutschler decided that it would be a good idea to know
what was the order in which the MP3 files from a particular
album were on the album CD itself. So, he used the last byte from
the comments field, which hardly anyone used, to store the track
number of the MP3 file. 
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But What About Songs With Long Titles?!
Since the ID3v1 tags had only a 30 character space for song titles,
album, artist and comments, song names like Sending Postcards From
a Plane Crash were simply shortened. Long album and artist names
were also similarly shortened. In addition to this, since the genre
query was accessed from a pre-defined list of only 80 genres, some
genres like Baroque, etc. could not be added.  So the world waited till
eventually, someone came along with a solution.

11.1.2 ID3v2
Incidentally, though both versions of the tag begin with ID3, ID3v2
has hardly any relationship with ID3v1. ID3v2 was designed with the
aim of removing the restrictions that the ID3v1 tags had, and also, to
add more information to the MP3 file. An ID3v2 tag allows users to
add, apart from the regular Id3v1 tag information, lyrics, pictures,
Web content, etc. to the MP3 file. But that is not the only difference
between the two versions of ID3 tags.

ID3v2 tags store information in what are called frames. Every
small portion of information in an ID3v2 tag is stored in different
frames; so the artist name, album name, lyrics of the song, artist
picture, etc. are stored in separate frame. As opposed to the limited
amount of content in an ID3v1 tag, each frame in an ID3v2 tag can
have a maximum size of 16 MB! The entire tag can have a size of
up to 256 MB! Also, whereas an ID3v1 tag is placed at the end of an
MP3 file, an ID3v2 tag is placed at the beginning. This is
particularly useful when it comes to streaming MP3s on the
Internet, as this bit of information is read immediately, allowing
the listener to know details of the song before he/she hears it.
Though there are some standard frames, like artist, lyrics, URL,
etc. some media players allow you to add your own bits of
information about the song as well. In addition, the ID3v2 tags can
be linked to music databases like CDDB (more on CDDB later in
this chapter) to get information automatically from the Internet. 

There are three currently versions of ID3v2 tags—ID3v2.2, v2.3
and v2.4.
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11.2 Managing Tags

ID3 tags (v2) let you store a host of information about your MP3
files on the MP3 file itself. This allows you to have a truly
enriching listening experience as your media player will display
the pertinent information in its listener interface. Most popular
media players today
also allow you to edit
the information that
is stored in the tag.
Winamp, for example,
lets you change
information for both
ID3v1 and ID3v2 tags
simultaneously. All
you have to do is right
click on the file in the
Playlist window and
select ‘View file info’. Alternatively, you can use the keyboard
shortcut [Alt] + [3]. Winamp also allows you to copy information
from the file’s ID3v2 tag to the ID3v1 tag, and vice versa.

Tag Clinic is a very
helpful application for
managing tags, especially
if you’re finicky about
capitalisations, spellings,
etc. of your tags. It can also
be used for editing the tags
of a batch of music
simultaneously. In
addition, it has a lot of
‘smart’ functions. For
example, it will automatically fill in information missing in a
file’s ID3v2 tag from its ID3v1 tag. Tag Clinic can also be used to
edit track information for a variety of formats including M4A,
AAC, WMA and OGG. 

Winamp has a very easy to use tag editor

Tag Clinic has a variety of ‘Smart’ functions
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Media players arrange music on the basis of information they
read in the files’ ID3 tags. Here’s a short tutorial on how to tag your
music in iTunes.

Tagging Files in iTunes

1. Add the MP3 files you want to tag in your Media Library by
pressing [Ctrl] + [O]
2. Right-click on the music file that you want to tag, and select ‘Get
Info’
3. The menu that opens shows you a summary of the track you have
selected with information like the file type, file size, bit rate, etc.
4. Select ‘Info’ and type in whatever fields you find necessary for
the song
5. You can also fill in
lyrics and artwork by
clicking on those
buttons
6. The ‘Options’ menu
allows you to adjust
the volume of the
song, give it a rating,
and change some
other song details
7. If you want to tag a
bunch of files at the
same time just select all the files you want to tag ([Shift] + [Left Click])
and once again select the ‘Get Info’ option in the right click menu.

iTunes has a simple tagging menu
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Some Simple Tips to Organise Your Music

Organising files and
organising tags should not be
done independent of each
other. It’s like keeping your CD
covers in one place and
keeping your CDs somewhere
else. Listening to hundreds of
MP3s before finding the one
you want really doesn’t make
much sense. It’s advisable to
keep songs of a particular
artist in that artist’s folder on your computer. iTunes pretty efficiently
organises your music collection in Artist > Album folders. All you have to
do is click Advanced > Consolidate Library and iTunes will automatically
arrange your music in the iTunes music folder. You can change the
directory of this folder by clicking Edit > Preferences and selecting the
Advanced menu. 

It is ideal if you use some standard format of track naming. For
example, Title-Album-Artist, or
some variation of that sort. So
your filenames will go
something like Wonderwall-
Morning Glory-Oasis.mp3. This
makes identifying the file easy
without opening a media
player. Tag Clinic (v4.2) is a
very nifty application that
allows you to rename your files
based on the information
stored in the ID3 tags. So as
long as your files are tagged with some basic information (song title,
artist name, etc.) Tag Clinic will change the filenames for you. You can
download Tag Clinic from www.kevesoft.com.

Let iTunes do all the hard work for you

Tag Clinic automatically renames MP3 files
on the basis of their ID3 tags
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11.2 Cataloguing Optical Media

As they say, first there was the Gramophone… The natural ‘evolution’
that audio playback formats have seen has led to the birth of the
Audio CD. The Audio CD is basically the great-great grandson of
those good ol’ vinyl records. When vinyl was the standard, music
wasn’t recorded on records as ‘data files’. Grooves were made on the
records that were the analog signals that a Gramophone’s needle
picked up and amplified. Essentially, the case was similar when the
audio CD was developed. Except here, the signals were digital, and
the needle was replaced by a laser. Music wasn’t stored on an Audio
CD as data files. So apart from the inlay that was provided with the
disc, there was no other digital identity that the songs had.

This meant that when you ripped the songs on to your computer
they were given names like Track 01-76432908.mp3. So what was
needed was another source from where the information about the
songs on the CD could be accessed.

11.2.1 CDDB
CDDB stands for Compact Disc DataBase. When you play a
Compact Disc in your computer, the media player that plays the
songs accesses this database to get information about the songs
on the disc. But how does the database know what CD you’re
playing? What happens is that an identification of the CD is
created on the basis of the length (time) of the songs, and their
order on the disc. This is then used to access information about
the whole CD, or, in case of a CD whose ‘identity’ is yet new, to
submit such information.

CDDB used to be a free database, but the project was sold (to a
company called Gracenote) and the terms of the license were
changed. This basically meant that developers needed to pay for the
use of the database. Also, since the database was accessed on the
basis of track lengths and their order, the database could not deliver
information about compilation discs.
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11.2.2 Freedb
Developers of media players soon shifted to use freedb, which, as the
name suggests, is a free database. However, the name CDDB is still
used as a generic. Freedb is essentially based on the original CDDB
concept, but has an open license (GNU General Public License) which
means it can be accessed for free.
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Convenience and customization; two ideals that have been the
cornerstone of every scientific development since man invented

the wheel. Everything from cornflakes to industrial equipment is
made so that its user gets exactly what he wants/expects from it.
Likewise with the MP3 player…

Syncing With
Portable Players
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12.1 Radio se MP3 tak

When radio programmes were first broadcast in India, loudspeakers
were set up near popular public areas so that people could hear local
folk music. At the time, owning a radio set of your own meant you
ate caviar for dinner and had four orderlies to take care of your Rolls.
But as radio has pervaded boundaries and classes, it has also expand-
ed its horizons. Speaking in the context of music, today there are
over 9,000 radio stations in the USA playing every conceivable genre
of music. Radio was the reason The Beatles were as big as they were.
Music charts were decided on how many people requested for the
songs of a particular band. But the power to choose still rested with
the people who owned the radio station.

And then came the Gramophone… From the Gramophone, to
Audio CDs to buying MP3s online; the point of people being able to
purchase music is that they get exactly what they want. Just like
cornflakes. What has happened is that we are living in a world where
we decide what we want, and that’s what we get. So from listening
to any random song on the radio, you can choose to listen to what-
ever you’ve got on your iPod.

12.2 Walk Man, Walk
Everyone had to have one. Sony’s Walkman was the most wanted
portable device in almost every country in the world. It actually
allowed people to listen to music while walking! The concept of
portability exploded on to the world and Nintendo made millions
selling their Gameboys. After the Walkman, no portable device real-
ly had the ‘cult’ following that Sony exploited so profitably. Until the
iPod. The iPod was and is the only true ‘cult’ device of our times. But
along with the iPod, a casual listener of music has the option of pur-
chasing several portable music devices that suit every budget. And
these days, with convergence becoming the keyword for everything
so much so that your car can also have a TV in it, portable music is
not restricted just to MP3 players. These days, cell phones double up
as portable music players as well. In fact, if you’ve been watching TV
recently, you’ll notice both Sony Ericsson and Nokia advertising their
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cellphones with MP3 players. Motorola, not to be left behind, has
already introduced the SLVR line of phones which have iTunes built
in! And you thought your mobile was only a video camera, word
processor, instant messenger and oh, did we mention, telephone?

12.3 Syncing Portable Devices with Media
Players

Here we will look at how you can sync your MP3 player with some
popular media applications.

12.3.1 iTunes with iPod
Apple is the master of interactive applications. In fact, they take
interactivity to a completely different level. iTunes automatically
syncs with your iPod every time it’s connected to your computer.
Unfortunately, the Windows version of iTunes will allow you to sync
only with the iPod while the Mac version allows you to sync iTunes
with other portable players as well.

Every time you add a new song to your Media Library on iTunes,
the song automatically gets added to your iPod as well. Also, all the
‘Information’ on songs that you have changed in your Media
Library including ratings, gets automatically updated in the iPod
when it’s connected to your PC. iTunes also allows you to automat-
ically copy any changes in your Playlists to your iPod. You cannot
however transfer files from your iPod to your PC. Don’t fret though,
a simple Google search will through up several third party tools
that allow this functionality for the iPod. The automatic update
function of iTunes can be turned off, for a manual transfer of files
to your iPod, by clicking Edit>Preferences and selecting the iPod
menu. You will need to have your iPod connected to your PC to
access this menu though. 

12.3.2 Windows Media Player
You can sync most portable media devices with Win-dows Media
Player 10. Just connect your device to your computer and click ‘Sync’
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in the main interface. WMP usually detects the device and displays all
the songs currently on the player. To transfer files to your device, click
‘Edit Playlist’ in the
Sync interface menu.
It will show you a list
of all the media files
on your computer
sorted by Artist. You
can select the sorting
parameter in the drop
down menu. Once you
have selected the files
you want to transfer
click ‘Start Sync’.

Like iTunes, WMP does not allow you to transfer files from the
device to your PC. WMP also has the option of automatic updates to
your device. Simply click ‘Set Up Sync’ in the Sync interface menu,
and select the ‘Automatic’ option. 

12.3.3 Musicmatch Jukebox
MJ also has a pretty nifty sync option with portable devices.
Connect your device to your computer and select ‘Portable Device’
in the Copy menu of the main interface of MJ 10. It detects the
device and displays all the tracks on it. You can add songs to the
player by clicking ‘Add Tracks’ and selecting them from your
Library. MJ has a lot of additional functionalities as well, apart
from the regular
Automatic Updates, etc.
Click on the ‘Tools’ drop
down and select
‘Settings’. Here you can
configure a variety of
options including vol-
ume leveling and over-
writing duplicate tracks
on your device.

MJ offers additional options for devices

WMP has the option of Automatic updates as well



Section IV

Share
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Online

You’ve done your tinkering. Mixed everyone from Asha Bhosle to
Guns ’n Roses into this awesome soundtrack that will keep the

party rocking into the wee hours of the night. Or you may be more
than just a geek with audio gear pouring out of your ears: a genuine
A R Rehman ready to take the music world by storm. 
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The question you have to ask yourself is: Do you have the guts to
publish? Fine. You feel you’re not ready for prime time. But the
itch just won’t go away. You want to share your files. Tell the
world you’re a music maestro. And you want to do it now! This
is what you do:

13.1 File Sharing

Online file sharing has a colourful and controversial history. Peer
to peer (P2P) technologies have evolved over the years, in response
to the various legal and social challenges of sharing copyrighted
material. In the early days, we had the likes of Napster that used a
centralised server to maintain searchable lists of files and directo-
ries of all users connected to the network. Individual users would
search for the file they wanted to download and request it direct-
ly from a machine on the network. The subsequent legal battles
finally shut down Napster in this form but it also paved the way
for decentralised distribution through file sharing programs such
as KaZaa, LimeWire, BearShare and others. 

13.1.1 P2P
These days, file sharing happens via several different P2P networks
(file sharing protocols); some of the most popular ones are Fast
Track, eDonkey, Gnutella and BitTorrent. P2P file sharing relies on
some method to pull different pieces of a file from various users
(nodes) on the network. This splits the resource and bandwidth
burden of sharing a file among several nodes, which (theoretical-
ly, at least) increases the efficiency of file sharing. While the prin-
ciples are similar, the methods used by each network result in
varying efficiencies, primarily depending on the type of connec-
tion you have. Thus, while BitTorrent may be most efficient for a
broadband user, Gnutella or eDonkey may be more suited for
those on dialup.

13.1.2 Legal Eagles—Is P2P legal?
This 64 million dollar question is still being fought over, with no
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clear winners on either side. Detractors say that file sharing hurts
sales and that you are breaking the law. Proponents of P2P argue
that file sharing actually helps sales and the “fair use” provisions
of copyright law makes it legal. Both trumpet numbers and
research studies supporting their claims. And that’s just a surface
scratch on the debates that rage!

As you can see, nobody is really clear on the way forward. At
least not yet. However, current copyright law is clear enough. You
cannot distribute copyrighted works without the permission of
the copyright owner. At best, file sharing is in a quasi-legal state
where you maybe punished if caught sharing copyrighted materi-
al without permission.

While we at Digit are a crazy bunch, we like to spin our loonies
on the right side of law! Likewise, we would encourage the entire
Digit community of readers to not break the law. Before sharing
copyrighted work, check the terms of the copyright. Most artistic
work (music, movies etc) and closed source software are usually
not shareable via P2P. That said, there is still plenty of shareable
material left over. Nearly all freeware, shareware and open source
software is shareable. Works in the public domain or those whose
copyrights have expired are also shareable. Music and movies
released under a Creative Commons license are shareable. Pick out
what you want, open your P2P client and go bleed your bandwidth
with the good stuff!

13.1.3 P2P Clients
With the exception of BitTorrent, which we will tackle in the next
section, sharing files with a P2P client is as simple as designating
a folder as “shared” and dropping all the files you want to share
into that folder. There are tens of hundreds (if not thousands!) of
P2P clients out there. Choosing one which suits your requirements
and personality is a matter of trial and error and you will need to
try a few of them out before you find the one which fits. One word
of caution, though: avoid those which come bundled with adware.
Other than taking up available bandwidth and making simple
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browsing a pain, adware are also notorious for hogging processor
and memory resources, effectively turning your machine into a
bullock cart. Look at the open source alternatives. They are
adware-free and offer as good or superior functionality. Some of
the more popular ones are:

❍ KaZaa Lite—This is a “clean” version of the popular KaZaa P2P
client and contains no adware, spyware or any other potential-
ly harmful software. It is especially easy for beginners. It is no
longer being updated but every version of KaZaa Lite is available
for download at http://tinyurl.com/rala6.

❍ Shareaza—A Windows-based, multi-network client that supports
download from any of the following networks: eDonkey2000,
BitTorrent, Gnutella, Gnutella2.

For a more comprehensive comparison, visit Wikipedia. For a
list of P2P clients, visit http://tinyurl.com/fbbvk, and for BitTorrent
clients, visit http://tinyurl.com/9svye.

13.1.4 P2P etiquette 1—Don’t be a leech!
Because P2P is all about file sharing, it is considered good eti-
quette to leave your P2P client open when you are not download-
ing anything. This will allow other sharers like yourself to retrieve
the files they want from your shared folder. A person who regu-
larly downloads stuff from the network and does not upload any-
thing is known as a leech. Some of the newer P2P software also
tries to discourage leeching by enforcing a “share ratio,” which is
the ratio of upload vs. download traffic. This is especially true in
BitTorrent downloads, where trackers require users to maintain a
minimum share ratio. So, within the limitations of juggling for
bandwidth with your 56k dialup connection or staying within the
transfer limit of your broadband connection, be good—don’t be a
leech and try and share as much as possible.

13.1.5 P2P etiquette 2—Don’t kill the LAN!
File sharing is also bandwidth intensive. On a LAN, depending on the
number of simultaneous uploads and downloads, a P2P client can
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quickly take over the bulk of network traffic slowing down every-
thing else. If things get out of control, this could lead to file sharing
being banned on your LAN. To prevent that it would be a good idea:

1. not to use the server or supernode mode
2.to limit downloads and uploads to one file at a time
3.to schedule downloads to off-peak hours
4.not to use P2P clients with adware as they can generate addi-

tional traffic even when nothing is being downloaded or uploaded

13.2 BitTorrent

Unlike other file sharing protocols, BitTorrent does not require
the entire file to begin sharing the file. BitTorrent splits a file into
smaller fragments which are uploaded to different peers (users).
The protocol is smart enough to request the rarest fragment first
from peers with the best network connections. This increases the
overall efficiency of the “swarm” (a group of peers sharing a full or
partial BitTorrent file) and makes for faster downloads and propa-
gation of the complete file to as many peers as possible in the
shortest possible time.

Also, unlike other file sharing protocols where you simply drag
a file into a shared folder, BitTorrent requires some additional
steps to create a “torrentable” file. There are four elements
involved in making your file available via BitTorrent:

a) A .torrent file. This is a metadata file containing the names,
sizes, and checksums of all the pieces that make up the shared
file or directory. 

b) A seeder. This is a peer who has a complete copy of the actual
file being shared. When you first make your file available via
BitTorrent you will be the seeder. 

c) A tracker. This is a server that coordinates connections among
the seeders and peers. Clients report to the tracker, which in
turn informs them of other available peers. Note that you can
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also create a tracker-less torrent as explained in §13.2.2.
d) A Web server that stores the .torrent file and makes it available

to other users. When you are informing your friends you will
send the link to download the .torrent file. 

You should also note that it is best NOT to zip or rar your
file/files/directory before torrenting. Most users delete the zip file
after extracting and hence are unable to reseed the torrent. 

13.2.1 DIY: Create a torrent
You can use any BitTorrent client that you are comfortable with; the
process of creating a torrent is similar across most clients with some
subtle variations emphasizing some aspect or the other. For this DIY
exercise we will use the μTorrent client which is relatively easy to
use with a simple interface. Creating a torrent is a five stage process:

a) Prepare file / files / folder
Copy all the files you want to tor-
rent into a single folder. For this
example we are going to share
some pictures of the Taj Mahal.

Note: Make sure you have
expanded all compressed
(.zip, .rar, etc.) files you’re
going to share.

b) Register on a tracker Web site
There are quite a few tracker Web sites out
there, but all of them require registration.
We’ve chosen to register on DataGalaxy
(datagalaxy.net), which is the largest legal
BitTorent site in the world. Once you’ve set
up your account and logged in, you will
need the Announce URL in the next step.
Click on the Upload link at the top of the
page. You should see a page like this:

xxxxxxx

xxxxxxx
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Copy the Announce URL to Notepad and keep it minimised.

c) Create the torrent
Open μTorrent and go to File > Create
a New Torrent. You will get a dialog
box like the one on the right. Click
Add Directory and select the directo-
ry where your files are stored. Paste
the Announce URL you copied to
Notepad. You can add a comment to
the Comment box if you wish to.
Accept the default “autodetect” for
Piece Size, do not check the Start
Seeding and the Private Torrent
boxes. A new dialog box will pop up,
as on the right.

Now click the “Create and save
as...” button. Give an easily recognis-
able file name and save the torrent
file along with the original files to
make it easier to find the torrent.

Click Close once the progress
meter reaches the end and the
“Close” button is enabled.

d) Upload the .torrent file to the
tracker site
To upload the torrent file we need to
go back to the upload page on the
tracker site, in our case,
datagalaxy.net. On the upload page
click the browse button and select the
.torrent file.

xxxxxxx

xxxxxxx

xxxxxxx

xxxxxxx
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Give a descriptive file name for the Torrent, an appropriate
Category and the description of the contents of the Torrent. Click
Send.

e) Seed the Torrent
To seed you will have to first down-
load the torrent from the site. Click
on the Torrents link at
the top of the page
and search for the tor-
rent. Click on Search
to narrow down the
list to your torrent.
Click on the floppy
disk icon in the Dl col-
umn and save the tor-
rent file in the same directory as your
original torrent file (created in step
c.) and the source files. This is very
important; many people mess up
their first torrent by not doing this.
When you save the file, your directo-
ry should now look something simi-

xxxxxxx

xxxxxxx

xxxxxxx
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downloaded from The Pirate Bay. In our case th
Mahal Pictures.torrent”. In the resulting “Add Ne
box, navigate to the .torrent file we created in st
As” section as shown below.

Make sure the “Open for Seeding” and “Star
boxes are checked and click OK.

Congratulations! You are now seeding your fi

You will need to leave μTorrent or your BitTo
for a sufficient length of time for the seed to p
peers. Send an e-mail to all your friends with the 
torrent file. Once enough seeds spread to other p
down your client.

13.2.2 DIY: Create a tracker-less torrent
One of the annoyances of BitTorrent has been th
a site to host the tracker that co-ordinates file sh
peers and seeders. Many people don’t have a We
public tracker sites provide a useful service, the
trackers begins to take a heavy toll on the bandw
owners. To circumvent this problem the concep
torrent was introduced. 

Creating a tracker-less torrent is somewhat e
other peers to locate your torrent is more diffic
creating a tracker-less torrent
first and then discuss the ways
in which you can expose your
torrent to peers. Since the cur-
rent version of μTorrent does
not support creation of track-
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rent.  

a) Prepare the file / files /
folder
This step remains the same
as in creating a tracker-
based torrent. Collect all
your files (or file) into a sin-
gle folder. Make sure they
are uncompressed, and fire up the BitTorrent cli

b) Create the torrent
In the BitTorrent program, click on File > Mak
press [Ctrl] + [N]. In the resulting dialog box c
select the files you want to torrent. For this exam
to make a torrent of firefox.exe. The resulting sc
like this.

Leave the piece size at 256KB. You can incr
your file size is very large (hundreds of MBs)
mended to leave it at 256KB for smaller (10 to 2
the “Use DHT” radio button and click Make. Th
be created and you will get a result screen as s

Click the “Start seeding” button and you’re d

Like in the case of the tracker-based torrent
leave our client open for a sufficient length of tim
reseed your torrent. However, discovering a trac
a bit more difficult than tracker based torren
ways BitTorrent clients contact peers with tracke

In the first method, a BitTorrent client will 
information with other peers it contacts. Durin
each tracker-less torrent capable client will infor
ability to host such torrents. These clients are kno
(or peers or users). DHT, which stands for Dynam
the method by which tracker-less torrents 

xxxxxxx
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Someone searching for a tracker-less torrent will input his search
term in his client and this is sent to all the peers the client is in
contact with. The peers in turn will send out the query to other
peers until a matching torrent is found. This is then reported back
to originating peer for further action. This process however is
slow; “peering,” as it is called, will take time, and some searches
may never return a successful result.

The other method, which is somewhat faster in building the
peer network, is to first built up a “peer routing table” (contact
details of peers) by downloading tracker-based torrents. Since the
tracker contains information about other peers in the torrent,
your peer routing table will get built that much faster. You can
then use this initial peer network to query for your tracker-less
torrent. One should note that there are no reliability guarantees
with a tracker-less torrent and the ability of peers who want your
file is curtailed by the “best effort” principle. That is, BitTorrent
will make the best effort to connect a peer to your tracker-less
torrent but there is no assurance of it happening.

That said, if you are sufficiently patient and leave your client
and net connection up and running, and assuming you have a
ready fan base to download your files, eventually your torrent
will get reseeded across many peers. This is applicable to both
tracker-based as well as tracker-less torrents. The only difference
is that reseeding your torrent will be much faster with a tracker-
based system than a tracker-less system.

13.3 Storing Online

The only downside with file sharing through P2P is the need to be
constantly connected to the Internet. With a large number of files
being shared or torrented this can quickly hog up quite a bit of
both download and upload traffic which in turn may result in
huge Internet bills. If this describes you, or if you are simply not
comfortable with the idea of P2P file sharing, you might want to
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look at online storage as an option.

After nearly winking out of existence following the dotcom
bust, online storage is back. Earlier, users had to deal with a sim-
ple web based upload that was slow as well as erratic. No more.
Online storage solutions are increasingly sophisticated with many
of them providing custom upload applets, Web APIs for integra-
tion with other applications, and RSS feeds for publishing
updates. There are hundreds of online storage solutions catering
to every mix of user needs. Since we are interested in sharing files
with others, the solution that you finally pick should offer file
sharing with friends as well as the general public. Some of the
ones which caught our eye are:

Streamload (www.streamload.com)
With a whopping 25 GB of free storage, Streamload just falls
behind Multiply which offers unlimited free storage. There are
some restrictions on monthly download (max 10 MB per file,
max 100 MB per month) but for the beginning file sharer this
can be more than sufficient.

Box.net (www.box.net)
Offers 1 GB of free space with no upload or download restrictions.
We really liked the feature of being able to e-mail a link of your file
for download by public with the option of password protection.
You will need to be premium user (read paid!) to use this feature.
Premium users also have private sharing, that is, sharing with
other box.net users.

Allmydata (www.allmydata.com)
Uses a slightly different approach by giving you 1 GB of free
online storage for every 10 GB of storage you give them from your
hard disk. The hard disk space you give them is used as a virtual
distributed RAID network hard disk.

eSnips (www.esnips.com)
Similar to box.net, this one gives you 1 GB of storage for all your
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files including photos, audio and video.

Multiply (www.multiply.com)
Strictly speaking, Multiply is not a storage solution but a “per-
sonal webspace” for free, unlimited hosting of your photos,
blogs and videos, along with a personal calendar and “My
Reviews” section.

Also, for a huge list of online storage sites, look at
http://tinyurl.com/eg83y.

13.4 Broadcast

It is said that the Internet is a great leveller. Nowhere is this more evi-
dent than in the publishing of personal music. No longer do you
require expensive hardware and software to set up an Internet radio
station that streams music from your home PC to your friends or any-
one else for that matter. The collection of tools that we review here
enables you to set up your own Internet radio station and stream
music or any other audio file 24x7. Listeners use the Internet to tune
into your station and listen to your selection of songs. So, what are
you waiting for—put on your RJ hat and get cracking!

13.4.1. Mercora
Mercora allows you to broadcast your personal music collection
over the Internet and listen to broadcasts from thousands of other
music lovers as well. You can’t download the songs but you can lis-
ten to them “live”—they are streamed to your computer from other
users. Similarly, your songs are streamed to other listeners who
tune into your “radio station.” To broadcast your music collection,
do the following:

1. Install the application
Go to www.mercoranetworks.ca/download.asp to download and
install the international version of the Mercora client application.
This is a standard Windows EXE installer. After the installation
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completes it will ask you to log in with your Yahoo!, Google, MSN
or AOL account. This login will also pull your contact address book
from the particular service, and Mercora will ask you to e-mail at
least one of your friends informing them about Mercora. Do that,
and you’re in.

2. Set up your Media Library
As with other media players, Mercora can scan your hard disk and
import all the songs on your PC into its media library. 

3. Set up Channels and Go!
You can group your music collection into a maximum of five
channels. Drag and drop your music files into each of the chan-
nels to set up your channels. You can also record a 90-second
audio introduction to your webcasts by clicking on the “Quick
Bump” button and using your microphone to record the intro.
You are now ready to go! Users wanting to hear your songs will
browse the Mercora network to locate your station and stream the
songs to their computer.

13.4.2. SHOUTcast
A bit more complex than Mercora, SHOUTcast consists of two
components: an audio server called SHOUTcast Distributed
Network Audio Server (DNAS) that distributes the streaming
audio, and an audio source via a Digital Signal Processing (DSP)
plugin to Winamp called SHOUTcast Source. 

The DNAS SHOUTcast server requires a dedicated IP address
and plenty of bandwidth to handle the audio streams that users
will request. Since this is outside the scope of most normal
users, we will not get into how to set up the server, but will
instead look at how to use the DSP Plug-in to connect to a
SHOUTcast hosting server.

1. Download the plugin
Before you install the plugin, ensure that you have the latest ver-
sion of Winamp (you will find it on any Digit CD). Next, go to
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http://tinyurl.com/4x2 to down-
load the latest version of the
plugin. This is a standard
Windows executable file—all
you need to do is run it to
install the plugin.

2. Configure the plugin
Before you configure the plug-
in, you will need to obtain the
following bits of information
regarding the PC that will host your SHOUTcast server:
❍ Server IP Address
❍ Port Number

❍

Password (if any)

Start Winamp and select Options > Preferences, or press [Ctrl] +
[P]. This will bring up the preferences dialog box. Select “DSP/Effect”
from the right pane and your screen should look like this.

xxxxxxx

xxxxxxx xxxxxxx
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S e l e c t
“ Nu l l S o f t
SHOUTcast
Source DSP
v1.90” (or
whatever is
the latest
v e r s i o n )
and click
“configure
active plug-
in”. This
will pop up the SHOUTcast source
window as in the screenshot on the
left below. Click on the Output tab
and select “Output 1” as in the second screenshot.

Enter the SHOUTcast server
IP address in Address field, the
server port number and pass-
word in their respective fields. If
you’re going to use your own PC
to broadcast your collection,
accept the defaults. Accept the
default values for Encoder (1),
Reconnection Timeout value (30 seconds) and check the
“Automatic Reconnection on Failure” box. Next, click on the

xxxx

xxxx

xxxx

Winamp’s DSP plugin configuration

The SHOUTcast Source
Window Output Tab
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Yellow Pages button and enter a
description that will get listed on
SHOUTcast directories around the
world. 

Check the “Make this server
public (Recommended)” box,
enter a descriptive name for your
server, enter the URL for the SHOUTcast direc-
tory, specify a genre for your music, provide
any AIM, ICQ or IRC channel information if
you want to chat with your listeners, and
check the boxes for “Enable Title Updates”

Next, click on the encoder tab as shown
on the right. In this screen, you configure the
encoder settings that will stream the music
to your server. For now, accept the default val-
ues of 24 kbps, 22.050 kHz Mono for MP3
Encoder. Once you’ve established your audio
stream you can experiment with higher con-
figurations. Basically, the higher the values,
the higher the sound quality, but the band-
width required is greater, as also increasing the strain on your sys-
tem resources.

You are now ready to stream. Switch back to the Output tab
window, click the “Connect” button. Your screen should now look
like this.

Upload an MP3 file and play it. You should be able to see the
bytes being sent out as shown on the next page.

You can also switch to the main window to see a graphical rep-
resentation of your streaming file. To get your friends to listen to
the stream all you need to do is send them the URL which they can
play from within Winamp. The URL will be of the form:
http://servername:port number (for example, http://digitshoutcast

xxxx

xxxx
xxxx
xxxx
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13.4.3 Podcasting
Podcasting, unlike Mercora or SHOUTcast, requires that you do
have a Web site where you can host your audio files. A “podcast”
refers both to the content and mode of delivery, and is usually
used for audio talk shows and less for music distribution. While
the file format can be any audio file format such as MP3 or WAV,
the delivery of the podcast is where you see the difference.
Podcasts are normally delivered via the RSS or Atom syndication
formats, which enable your listener population to subscribe to
your RSS or Atom feeds and listen to your talk show as and when
they are posted. Podcasting involves the following steps:

1. Creating your podcast audio file
The first step in podcasting is to create your audio content. You can
use Audacity or any of the other tools we have reviewed in the ear-
lier chapters to create your audio talk show. Record your audio and
add any music effects you wish to use. Once done, save your audio
file as an MP3 and note down the file size in bytes. To get the file
size, right-click on the MP3 file and select Properties. For example,
if your system shows the file size as “3.89 MB (4,078,961 bytes)”,
you should note down 4078961 without the commas.

2. Create the RSS Feed File
The RSS feed file is actually a text file in the XML format. Similar
to HTML, you will need to use tags to specify the various parame-
ters of your RSS Feed. Use Notepad to copy the below code and
modify according to your requirements.

<?xml version="1.0"?>
<rss version="2.0">
<channel>

<title>Digit Podcast</title>
<link>http://www.digitpodcast.com/mypodcast.mp3</link>
<description>My first podcast</description>

FAST TRACK
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<language>en-us</language>
<copyright>2005</copyright>
<lastBuildDate>Today's Date*</lastBuildDate>
<webMaster>youremail@digitpodcast.com</webMaster>
<ttl>1</ttl>
<item>

<title>Digit Talk Show - Monday</title>
<description>Here's Digit's Monday Podcast.</description>
<pubDate>Today's Date*</pubDate>

<enclosure url="http://www.digitpodcast.com/mypodcast.mp3"
length="4078961" type="audio/mpeg"/>

</item>
</channel>
</rss>

*The date should be in the format ddd, mm dd yyyy, hh:mm:ss
+0530. The +0530 will indicate that you are five and half hours
(India) ahead of GMT. If you are in a different time zone, change
the +0530 to your corresponding time zone. For example, if you
are podcasting from Dubai on May 3rd, 2006 at 2:08 PM, your date
information would read something like this: Wed, May 03 2006,
14:08:00 +0400
Note: Make sure you use a text editor such as Notepad, not MS

Word—the RSS file should be without any hidden format-
ting information and should be a plain text file. 

Save the file with a .rss extension, say digitpodcast.rss.

3. Upload the RSS file and the MP3 file
You should now be able to upload the RSS and MP3 file to your
Web site now. Use an FTP program or some other upload utility to
upload the file to your website. Make sure you have the correct
folder locations for the MP3 file in the enclosure tag in your RSS
file. In our example the enclosure tag was:



<enclosure url=”http://www.digitpodcast.com/mypodcast.mp3”
length=”4078961” type=”audio/mpeg”/>

This indicates the mypodcast.mp3 file is in the main directory
with a file length of 4078961 bytes.

4. Validate the RSS file
Now go to an RSS validator and enter the address to your RSS file
(for example, http://www.digitpodcast.com/digitpodcast.rss) to ver-
ify that your RSS file is without errors. You can use http://rss.script-
ing. com/ or http://validator.w3.org/ to validate your RSS file. 

Once validated, you can now provide a link to the RSS file on
your Web page, or e-mail the link to your friends or mailing list. 

You are now podcasting!

People subscribing to your feeds will automatically see your
new feed in their favourite RSS reader.

Note: You can also use automatic RSS feed creation software to
publish your RSS feeds.
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Share Offline

If you’re one of those with tens and hundreds of audio CDs
scattered all over the place with no clue as to how to organise the

clutter, then CD ripping and burning is for you.  This section will
walk you through the steps involved in ripping the songs from your
music collection and burning an audio CD from your digital music
collection.  We will also show you how to create cover art and use
some software and hardware tools to label your CD.
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14.1 Ripping And Burning CDs

Ripping, as the name indicates, is the process of extracting audio
files from your CDs. Audio CDs are normally recorded in a “loss-
less” format such as WAV. This is an exact replica of the sound as
it was recorded. The ripping process compresses and encodes the
songs in a “lossy” format such as MP3 where some audio informa-
tion is compromised. (See chapter 2 for more on formats). CD burn-
ing is the process of writing files to a writeable CD using CD writ-
ing software. For MP3 files, the process of ripping and burning has
been made somewhat simpler by media player software that
enable convenient ripping and burning from within the program
itself. There is some difference in the ripping and burning speeds
for the free and paid versions. Popular choices for media players
include Windows Media Player, iTunes, Musicmatch Jukebox,
Winamp, RealPlayer and many others. Thankfully, the procedure
followed is mostly similar, with a short learning curve to get used
to the user interface. To show you how to rip and burn CDs, we’ve
used Musicmatch Jukebox, which you can download from
http://musicmatch.com.

14.1.1 Ripping
Insert your audio music CD into the disc drive, open Musicmatch
Jukebox, and click on the “Copy from CD button”. The “Recorder”
window will pop up and Musicmatch will extract all the song
information for your CD as shown below. 

If you are connected to the
Internet, you can let the album infor-
mation download from the online CD
database (CDDB). If Musicmatch can’t
find the information or if you aren’t
connected, you can manually input
the details as well. 

To verify that the encoding settings
are optimum, click on Tools > Settings to open the Settings dialog

The Recorder window
populated with a song list
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box as on the right. You can use this dia-
log box to modify various recording set-
tings. For now, we will accept the default
settings after verifying that the record-
ing will be at 128 kbps—a good balance of
file size and sound quality.

Close the Recorder Settings dialog
box and click on “Start Copy”. The
recorder will now start copying the
tracks on your CD to your hard disk as
shown below.

Soon, the songs will have been
copied to your hard disk and will be
available in your media player’s library.

14.1.1. Burning
Burning is just as easy with
Musicmatch. Insert a blank CD into
your CD writer. Click the “Burn
to CD” button to bring up the
Burner Plus dialog box.

There are on-screen prompts
throughout to get you through a
basic burning session. Drag and
drop the files you want into the
Burner Plus window. The soft-
ware will inform you when the
CD has reached maximum capacity, so
you can be certain that you won’t drag
in more files than can be burned.

You are now ready to burn the CD.
You may also choose to explore the vari-
ous options under Tools to see what else

Recorder Settings

Copying and Encoding in
Progress

Files Ready to Copy

Songs in Media Library
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you can do. For now, accept the default
settings and press “Burn”. The burn
process will now start and display the
dialog box on the right.

It is best not to run any other appli-
cations during burning and wait for the
process to complete before using the PC
again. Once the burn process is completed, Musicmatch will alert
you. Your CD is now ready for distribution!

14.2. Creating CD Cover Art

Cover art can give your CD package a professional and compelling
look that will keep people interested enough to listen to your
work. It also serves as a vehicle to reflect the theme of your com-
pilation using engaging graphics, pictures and text that, when
used appropriately, will create a powerful impression.

14.2.1. Designing cover art
Generally, the CD cover can be considered as composed of three ele-
ments: the cover card or insert, the tray card and the CD face label.

The cover insert is what people see first when they pick up
your CD. This will have the track listings, artwork, and photo-
graphs of you (and your band) and could be in the form of a book-
let with the other details like lyrics and information about the CD
contents. The tray card sits under the (usually black or white) CD
tray. It should be similar in artwork to the cover insert, and should
be folded at the spine so that people can read the title along the
edge of the CD. The CD label, again consistent with the graphics
on the insert and tray card, will be printed or stuck on the CD face.

You can use a combination of artwork and photographs to give
a distinctive impression of your sound as well as provide a recog-
nisable identity for yourself and/or band. Photographs can be rela-

Burning Songs to CD.
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tively inexpensive, especially with the proliferation of multi-
megapixel digital cameras that can be directly transferred into
your graphics software with little or no loss of color information.
If you are keen on artwork, and you find that you aren’t up to
speed in that area, you could try roping in a friend who knows
graphics design, or visit one of the graphics design schools in your
area. Senior-year students should be more than willing to provide
you with eye-catching designs at a fraction of the cost of profes-
sional design shops. You can also scour the Internet for royalty-fee
artwork designs.

When working with images, make sure you’re using a mini-
mum resolution of 300 dpi. Higher than that is always better!
Colour information and details tend to get lost below 300 dpi,
making your printout look shabby. Similarly, the choice of text
and font styles should also be given careful consideration.
Remember that your cover art is a combination of the graphics
image as well as the superimposed text. While the text should be
legible and easy on the human eye, it should not crowd out the
rest of the artwork, unless you have a very strong reason for that
stylistic choice. 

Choosing a font style is no easy task. You cannot just slap on any
old font. If you are clueless about what fonts to use, a good idea
maybe to check out other CDs in your genre and look at the kind of
fonts and artwork those artists are using. It might give you an idea
of what works and what will not. Some cover art has an instant
direct appeal. Others just slip past you without catching your eye.
When using dark colors or a background filled with images it
might be difficult for the text to stand out on its own. In that case,
it would be good idea to use a solid color box and embed the text
inside that to make it stand out and not get lost in the background.

14.2.2. The software
You will need graphic design and desktop publishing software to
design your artwork. For best results, you may need to use a com-
bination of graphics and image editing software before getting
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your final output. Some of the popular choices include
Photoshop, InDesign and Illustrator. However, depending on the
exact type of artwork you use, you may be able to get satisfying
results with even just one of these programs. Get your hands on
the May 2006 edition of Digit to get an in-depth how-to for work-
ing with Photoshop.

Some programs have special inbuilt features and Wizards to
help you in designing the artwork for CD covers. This can be big
help as it will save you hours of sweating over your CD jewel case
measuring the dimensions, trying to get the sizing right.
Additionally, there are many CD cover and label software that will
take over from where the graphics software stops. You can, in most
cases, import the image file and directly print on plain or spe-
cialised paper and stickers that can be then fixed into your jewel
case. Two of the most popular label creation software are Easy CD
& DVD Cover Creator (www.easycoverdesign.com) and CD Label
Designer (www. datalandsoftware.com/cdlabel/). Both these pro-
grams can work with images (to some extent) and text, but ideal-
ly, you should import your ready-for-printing image file and use
that for printing. Both programs have a Wizard interface to make
it simpler and easier for you to quickly get your work done. Let’s
look at CD Label Designer’s Wizard to see how it handles the print-
ing of cover and label design.

Open the program and click on File > New Wizard, to bring up
the dialog box as on the right.

Accept the default settings 
for the design template and

let the software read the titles
from the CD.

Give a title for the CD and
specify where all you want it to
be printed. The software has the
“Inside” checkbox cleared, indi- Open up the Wizard



XIVSHARE OFFLINE

173

DIGITAL AUDIO

FAST TRACK 

cating that the title won’t be printed on the inside “side” of the
cover insert. You can leave the title blank and clear all the check-
boxes if your text is already in your image file. Insert your graphics
file at this stage and specify where it should be printed. You can now
choose to save and/or print in this step. We have decided to only save
for now to review the results in the program before printing.

Click Finish, and CD Label Designer will automatically check
the CD in the drive to identify
the song titles. You can now
review the labels in Label
Designer and make any addi-
tional changes required before
printing. For printing, you
need to pre-cut stationery for
the various elements that
make up the cover art. Be pre-
pared to waste a few sheets till you get the alignment right with
your printer.

Wizard Step 2Wizard Step 1

Wizard Step 4Wizard Step 3

CD Titles Extraction



XIV SHARE OFFLINE

174

DIGITAL AUDIO

FAST TRACK

14.3. LightScribe

One of the main problems with CD face labels is getting the align-
ment exactly right. Even if you do have a label fixing applicator, the
alignment may go off, or bubbles might form between the label
sticker and the CD face, spoiling your sticker. One solution is to use
LightScribe (www.lightscribe.com), a hardware-based device that
uses specially coated CD-R, DVD+R and DVD-R discs to laser-etch
your CD face artwork without all the above-mentioned hassles.

To use LightScribe you need the following:
❍ A LightScribe-enabled CD or DVD-Writer
❍ Specially coated writeable CDs or DVDs
❍ A LightScribe-compatible label creation software
❍ The LightScribe system software

LightScribe comes as part of regular CD and DVD-Writers, and are
available from many popular vendors both as internal as well as exter-
nal disc writers. Visit the site and follow the links to find out vendors
who can provide you with LightScribe-enabled devices in your area.
LightScribe discs are regular writeable CDs and/or DVDs but with a
special gold coating on the face that will react to the laser etching
process. The artwork, however, will only appear in black and white
or greyscale as of this writing. The company says they are planning
to bring out colour background discs this year (2006). LightScribe-
enabled label creation software will recognise the presence of a
LightScribe disc writer and can send your print output directly to
the device for laser etching. You can try out SureThing SE (www.
lightscribe.com /files/setup.zip), a free label creation software.

In addition to the above, you also need the LightScribe system
software. This is normally bundled with your hardware or the label
creation software. A universal version is also available along with
an extended print contrast utility and label templates in the sup-
port area of the LightScribe Web site (www.lightscribe.com/support
/index.aspx).




